USER GUIDE applied

biosystems
by&{é technologies”

AmpF/STR® Identifiler® PCR Amplification
Kit

for use with:
200 reaction kit (Part no. 4322288

Publication Number 4323291 Rev. J
Revision Date August 2012

o
technologies™



For Forensic or Paternity Use Only.
Information in this document is subject to change without notice.

LIFE TECHNOLOGIES CORPORATION AND/OR ITS AFFILIATE(S) DISCLAIM ALL WARRANTIES WITH RESPECT TO THIS DOCUMENT, EXPRESSED OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THOSE OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT. TO THE EXTENT
ALLOWED BY LAW, IN NO EVENT SHALL LIFE TECHNOLOGIES AND/OR ITS AFFILIATE(S) BE LIABLE, WHETHER IN CONTRACT, TORT, WARRANTY, OR
UNDER ANY STATUTE OR ON ANY OTHER BASIS FOR SPECIAL, INCIDENTAL, INDIRECT, PUNITIVE, MULTIPLE OR CONSEQUENTIAL DAMAGES IN
CONNECTION WITH OR ARISING FROM THIS DOCUMENT, INCLUDING BUT NOT LIMITED TO THE USE THEREOF.

TRADEMARKS

The trademarks mentioned herein are the property of Life Technologies Corporation or their respective owners.
TagMan and AmpliTaq Gold are registered trademarks of Roche Molecular Systems, Inc.

Windows and Windows Vista are registered trademarks of Microsoft Corporation.

EasiCollect is a registered trademark of Whatman Limited. FTA is a registered trademark of Whatman International Limited. Whatman is a registered
trademark of GE Healthcare Companies.

Minitab is a registered trademark of Minitab, Inc.

Mac OS is a registered trademark of Apple, Inc.

© 2012 Life Technologies Corporation. All rights reserved.



Contents

About ThisGuide . ... i i et ee e ens 9
ReVISION histOry . oo 9
PUIPOSE o 9
B CHAPTER T OVeIVIEW ..ottt i e et e ee e e iae i eaaneans 11
ProdUC OV VIBW . oo (X
PUIPOSE . o oo 11
Product description . .. ... oo (K
AboUt the Primers . ... 1
Lociamplified by the Kit ... ... o 12
Allelic ladder profile ... ... o e 13
Control DNA 9947A profile . .. ..o o 14
WoOrKflow OVerVIeW . .. 15
Instrument and software OVerVIEW . ... ... e 16
Data Collection and GeneMapper® ID or ID-X Software ....................ccccviin... 16
Instrument and software compatibility ............ .. 16
About multicomponent analysis .. ... 16

How multicomponent analysis Works . ....... ... .. i 17
Materials and eqUIPMIENt ..o o 18
Kit contents and storage ....... ... 18
Standards for samples . ... ... 18

B CHAPTER 2 Perform PCR ... ... o it 19
Required user-supplied reagents . ... ... e 19
DNA quantification .. ... oo 19
Importance of quantification ....... ... .. e 19
Methods of quantifying DNA .. ... 20
Prepare the amplification kit reactions . .. ... 21
Perform PO R ..o 22
Amplification using bloodstained FTA® cards ...ttt 22

AmpFISTR® Identifiler® PCR Amplification Kit User Guide 3



Contents

B CHAPTER 3 Perform Electrophoresis ......................... 25
Allelic ladder requiremMENtS . . ... oo e 25
Section 3.1 3100/3100-Avant and 3130/3130xlinstruments ....................... 27
Set up the 3100/3100-Avant or 3130/3130x( instrument for electrophoresis ................... 27

Reagents and parts . ........ o 27
Electrophoresis software setup and reference documents ............. ... ... ... 27
Prepare samples for electrophoresis on the 3100/3100-Avant or 3130/3130xl instrument . .. . . .. 28
Section 3.2 3500/3500xL Series instruments ............ ... ... i, 29
Set up the 3500/3500xL instrument for electrophoresis ... 29
Reagents and parts . ........ o 29
Electrophoresis software setup and reference documents ............. ... ... .. ... 29
Prepare samples for electrophoresis on the 3500/3500xL instrument ....................... 29
Section 3.3 310 Instrument ... ... . 31
Set up the 310 instrument for electrophoresis ......... ... i 31
Reagentsand parts . ........ . 31
Electrophoresis software setup and reference documents .. ..., 31
Prepare samples for electrophoresis on the 310 instrument . ............... ... ooiiat. 31
CHAPTER 4 AnalyzeData ...........ccoiiiiiiiiiii i, 33
Section 4.1 GeneMapper® ID Software .............c.iiiiiiii i 33
Overview of GeneMapper® ID Software ......... ...t 33
NSt TUMIENES 33
Before you start ... ... 34
Set up GeneMapper® /D Software for dataanalysis ... 34
File Mames . 34
Before using the software for the firsttime ............ .. . . 34
Import panels and bins .. ... ... e 35
Create ananalysis method . ... ... e 39
Generaltab settings ... ... i 40
Allele tab settings . . .. ..o e 41
Peak Detectortab settings . ... ... . e 42
Peak Quality tab settings ... ... .o 43
Quality Flags tab settings . ... A
Create size standard . ......... o 44
Analyze and edit sample files with GeneMapper® /D Software .............................. 46
Examine and edita project . ... ..o i 47
Formore information .. ... ... 47

AmpFISTR® Identifiler® PCR Amplification Kit User Guide



Contents

Section 4.2 GeneMapper® ID-XSoftware . ....... ..ot 48
Overview of GeneMapper® ID-XSoftware . ...... ...t 48
NS UM NS oo e 48
Before you start . ... ... 48

Set up GeneMapper® ID-X Software for dataanalysis ............. ... ... ... .. .. 49
Panel, bin, and stutter file version . ......... ... 49
Before using the software for the firsttime ... ... ... .. .. 49

For more information . ... ... .. 49
Check panel, bin, and stutter file version ........... ... . . . . 50
Import panels, bins, and marker stutter ......... ... . 50
Create ananalysismethod ....... ... .. 55
Generaltab settings . ... ... 56
Allele tab settings .. ..o oo 57
Peak Detectortab settings ....... ... .. 58
Peak Quality tab settings .. ... ... 59
SQ&GQtab settings .. ... 60
Analyze and edit sample files with GeneMapper® ID-X Software ............................ 61
Examine and edit a project . ... ... 62
Formore information . ... ..o o 62
B CHAPTERS5 ExperimentsandResults ........................... 65
Section 5.1 Developmental Validation .......... ... .. .. . . . i i 66
O BV W o e ettt e 66
Importance of validation . ... ... ... 66
Experiment conditions . ... ... 66
Developmental validation . ... .. . e 67
DAB 8.1.1 Developmental Validation .............c e 67

PCR COmMPONENtS . o oo 67
Thermal cycler parameters .. ... e 67
AmpliTag Gold® DNA Polymerase activation ..., 68
Accuracy, precision, and reproducibility .......... ... 69
DAB 8.1.2 ACCUTACY . . o ettt ettt e e e e e e e e e e e e 69
Precision and size WiNAOWS . . ... ... o e 69
Extra Peaks in the electropherogram . ... ... . 77
Causes of extra Peaks ... ...ttt 77
Stutter products . . ... 77
Addition of 3" Anucleotide . . ... 81
ArtifactS . o o e 81
Characterization of loCi ... ... 82
DAB 8.1.2.1 Documentation . .. ... i e 82

OV IV BW . o ettt 82
Nature of the polymorphisms . ... . 82
IRt aNCe o oo 83
MapPINg oo 83

AmpFISTR® Identifiler® PCR Amplification Kit User Guide 5



Contents

SPECIES SPECITICIEY - 83
DAB 8.1.2.2 Species Specificity . . ... ..ot 83
NS IVIEY 85
DAB 8.1.2.2 SenSitiVIty . ...ttt 85
Effect of DNA quantity on results and importance of quantitation ....................... 85
ALty .. 86
DAB 8.1.2.2 Stability . ... 86
Lack of amplification of some loci ....... ... 86
Differential and preferential amplification ........ ... ... L. 87
Effect of inhibitors ... 87
Degraded DNA .o o 88
Multiplex amplifications . ... ... e 89
MiIXEUFE STUTIES . . . oot e 91
DAB 8.1.2.2 Mixture StUdIeS . ... . 91
Mixed specimen studies . ... ... i e 91
Data interpretation ... ... o 94
Minimum sample requiremMent . ... 94
Population data . ... e 94
DAB 8.1.2.3 Population Data . . .. ... .o e 94
DAB 8.1.2.3.1 Population Distribution Data ........ ... .. i 94
0= T 95
Population samples used in these studies . ....... ... 95
Allele freqUeNCIES . . . oot 95
Analyzing the four databases ........... . 104
Low-frequency alleles . ... ... o i 104
MUtation Fate ... 105
Estimating germline mutations . .......... .. e 105
Additional mutation studies ........... 105
Probability of identity . . ... ... 105
Probability of paternity exclusion . ... ... . 106

Section 5.2 Performance Verification After Primer Manufacturing Process
I ProvEmMENtS .. 107

Section 5.3 Performance Validation After Buffer and Enzyme Component

Replacement . ... o 108
0= TP 108
EXPErIMENtS o 108
Reproducibility study . ... ... 109
Intracolor balance ... .. o 109
StULtEr PEICENTAGES . . . 110
Y ] T o € 110
SeNSItIVItY StUAY ..o 1M1
Mean referenced peak height .. ... .. 11
DNA concentration and peak height ....... ... .. . . 112

AmpFISTR® Identifiler® PCR Amplification Kit User Guide



Contents

Allelic dropoUt .. o o 113

Genotype CONCOrdanCe . . ..ottt M4
INhibItioN StUAY ... e 114

Mean referenced peak height, minimum referenced peak height, and intracolor balance 114

Allelic dropouUt .. oo 117
CONCIUSIONS . e 118
APPENDIX A Troubleshooting ........... ..., 119
APPENDIX B Ordering Information ............... ... ... ..o... 121
Equipment and materials notincluded . ........... . 121
APPENDIXC PCRWOrk Areas .......coviiiiiinennnnnnnnnnnns 125
Work area setupand labdesign .. ... e 125
PCR setup Work area . . ..o oo e 125
Amplified DNAWOIK area . ... oo e 126
APPENDIXD Safety ......ooiiiiiiii i e e 127
Chemical safety .. ... 128

Specificchemical handling . ... 128
Biological hazard safety . ... 129
Documentationand Support ....... ...l e 131
Related documentation . ... 131
Obtain SDSS . . vt 132
Obtain SUPPOIt ... 132
Limited Product Warranty . ... .. e 132
Bibliography ... e 133
o =) G 137

AmpFISTR® Identifiler® PCR Amplification Kit User Guide 7



Contents

8 AmpFISTR® Identifiler® PCR Amplification Kit User Guide



About This Guide

IMPORTANT! Before using this product, read and understand the information the

“Safety” appendix in this document.

Revision history

Revision Date Description
A May 2001 New document.
B May 2001 Update GeneAmp® System 9700 part numbers.
C May 2005 Change to limited licensing information.
D August 2006 Change to limited licensing information.
E September 2010 Change to limited licensing information.
F April 2011 Change to limited licensing information.
G March 2012 Change to limited licensing information.
H May 2012 e Remove Mac 0S® procedures.
e Add 3100, 3100-Avant, 3130, 3130x!, 3500,
3500xL Genetic Analyzer information. Added
GeneMapper® /D Software and GeneMapper®
ID-X Software information.
J August 2012 Add validation experiments and results for primer
manufacturing process improvements and buffer
and enzyme kit component changes.

Purpose

The Applied Biosystems AmpF(STR® Identifiler® PCR Amplification Kit User Guide
provides information about the Applied Biosystems instruments, chemistries, and
software associated with the AmpF(STR® Identifiler® PCR Amplification Kit.
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Overview

B ProducCt OVeIVIEW . ..ot e 11
B OWOTKEIOW OVEIVIEW . . oottt e e e e 15
B Instrument and software oOverview . ......... ... 16
B Materials and equipment ............. . i 18
Product overview
Pu rpose The AmpFlSTR® Identifiler® PCR Amplification Kit is a short tandem repeat (STR)

multiplex assay that amplifies 15 tetranucleotide repeat loci and the Amelogenin
gender-determining marker in a single PCR amplification:

e All thirteen of the required loci for the Combined DNA Index System (CODIS)
(Budowle et al., 1998).

¢ Two additional loci, D251338 and D195433.

Product The Identifiler® Kit contains all the necessary reagents for the amplification of human
description genomic DNA.

The reagents are designed for use with the following Applied Biosystems instruments:
¢ 3100/3100-Avant Genetic Analyzer
* Applied Biosystems 3130/3130x! Genetic Analyzer
* Applied Biosystems 3500/3500xL Genetic Analyzer
¢ 310 Genetic Analyzer
* GeneAmp® PCR System 9700 with the Silver 96-Well Block
* GeneAmp® PCR System 9700 with the Gold-plated Silver 96-Well Block
*  Veriti® 96-Well Thermal Cycler

About the primers The Identifiler® Kit employs the same primer sequences for all loci common to other
AmpF(STR® kits (except the MiniFiler kit). A degenerate unlabeled primer for the
D851179 locus was added to the AmpF(STR® Identifiler® Primer Set in order to
address a mutation observed in a population of Chamorros and Filipinos from Guam
(Budowle et al.,1998b and Budowle et al., 2000). The addition of the degenerate primer
allows for the amplification of those alleles in samples containing this mutation
without altering the overall performance of the Identifiler® Kit. The original validation
data in this guide (Section 5.1 on page 66) were generated prior to the addition of the
degenerate primer. Data showing equivalence with the degenerate primer has been
published.

AmpFISTR® [dentifiler® PCR Amplification Kit User Guide 11



Loci amplified by
the kit

Chapter 1 Overview
Product overview

Non-nucleotide linkers are used in primer synthesis for the following loci: CSF1PO,
D13S317, D165539, D251338, and TPOX. For these primers, non-nucleotide linkers are
placed between the primers and the fluorescent dye during oligonucleotide synthesis
(Butler, 2005, Grossman et al., 1994, and Baron et al., 1996). Non-nucleotide linkers
enable reproducible positioning of the alleles to facilitate interlocus spacing. The
combination of a five-dye fluorescent system and the inclusion of non-nucleotide
linkers allows for simultaneous amplification and efficient separation of the 15 STR
loci and Amelogenin during automated DNA fragment analysis.

The following table shows the loci amplified, their chromosomal locations, and the
corresponding fluorescent marker dyes. The AmpF(STR® Identifiler® Allelic Ladder is
used to genotype the analyzed samples. The alleles contained in the allelic ladder and
the genotype of the AmpF/(STR® Control DNA 9947A are also listed in the table.

Table 1 Identifiler® Kit loci and alleles

Locus designation Chromosome Alleles included in AmpF{(STR® Dye ControlDNA
9 location Identifiler® Allelic Ladder label 9947A
D851179 8 8,910, 11, 12,13, 14, 15, 16, 17, 18, 19 6-FAM™ 13t
D21S11 21911.2-q21 24, 24.2, 25, 26, 27, 28, 28.2, 29, 29.2, 30, 30%
30.2,31,31.2,32, 32.2, 33, 33.2, 34, 34.2, 35,
35.2, 36, 37, 38
D75820 7911.21-22 6,7,8 910,11, 12,13, 14,15 10, 11
CSF1PO 5g33.3-34 6,7,8 9,10, 11,12, 13, 14,15 10,12
D351358 3p 12,13, 14, 15, 16, 17, 18, 19 VIC® 14,15
THO1 11p15.5 4,5,6,7,8,9 93,10, 11, 13.3 8, 9.3
D13S317 13q22-31 8, 9,10, 11,12, 13, 14, 15 118
D165539 16q24-qter 5,8,9,10, 11,1213, 14, 15 1,12
D251338 2g35-37.1 15,16, 17,18, 19, 20, 21, 22, 23, 24, 25, 26, 19, 23
27, 28
D19S433 19912-13.1 9,10, 11,12, 12.2, 13, 13.2, 14, 14.2, 15, NED™ 14,15
15.2, 16, 16.2, 17, 17.2
VWA 12p12-pter 11,12, 13, 14, 15, 16, 17, 18, 19, 20, 21, 22, 17,18
23, 24
TPOX 2p23-2per 6,789 10, 11,12, 13 gft
D18S51 18g21.3 7, 9,10, 10.2, 11, 12, 13, 13.2, 14, 14.2, 15, 15,19
16,17, 18, 19, 20, 21, 22, 23, 24, 25, 26, 27
Amelogenin X: p22.1-22.3 X, Y PET® X
Y: p11.2
D55818 5g21-31 7,8,9,10, 11,12, 13, 14, 15, 16 113t
FGA 4q28 17,18, 19, 20, 21, 22, 23, 24, 25, 26, 26.2, 27, 23, 24
28, 29, 30, 30.2, 31.2, 32.2, 33.2, 42.2, 43.2,
44.2, 652, 46.2, 47.2, 48.2, 50.2, 51.2

T For CODIS purposes
I For CODIS purposes
§ For CODIS purposes
T+ For CODIS purposes
1 For CODIS purposes

12

, profile reported as 13, 13.
, profile reported as 30, 30.
, profile reported as 11, 11.

, profile reported as 8, 8.

, profile reported as 11, 11.

AmpFtSTR® Identifiler® PCR Amplification Kit User Guide



Chapter 1 Overview 1
Product overview

Allelic ladder Figure 1 shows the allelic ladder for the Identifiler® Kit. See “Allelic ladder
profile requirements” on page 25 for information on ensuring accurate genotyping.

Figure 1 GeneMapper® ID-X Software plot of the AmpF(STR® Identifiler® Allelic Ladder
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Product overview
Control DNA 9947A  Figure 2 shows amplification of Control DNA 9947A using the Identifiler® Kit.

profile

Figure 2 1 ng of Control DNA 9947A amplified with the Identifiler® Kit and analyzed on the Applied Biosystems 3130x{ Genetic
Analyzer
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Chapter 1 Overview
Workflow overview

Workflow overview

Perform
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Chapter 1 Overview
Instrument and software overview

Instrument and software overview

This section provides information about the Data Collection Software versions
required to run the AmpF(STR® Identifiler® PCR Amplification Kit on specific
instruments.

The Data Collection Software provides instructions to firmware running on the
instrument and displays instrument status and raw data in real time. As the
instrument measures sample fluorescence with its detection system, the Data
Collection Software collects the data and stores it. The Data Collection Software stores
information about each sample in a sample file (.fsa), which is then analyzed by the
GeneMapper® ID or ID-X Software.

Data Collection and
GeneMapper® ID
or ID-X Software

Instrument and
software

Table 2 Software specific to each instrument

ipeps Operating Data Collection .
compatibility Instrument system Software Analysis software
3500/3500xL e Windows® XP 3500 Series GeneMapper® /D-X Software
o Windows Data Collection | v1.2 or higher

Vista® Software v1.0
3130/3130x! Windows® XP 3.0 » GeneMapper® ID

- Software v3.2.1
3100/3100-Avant | Windows® NT 1.1 (3100)

1.0 (3100-Avant)

Windows 2000 2.0
310 Windows XP 3.1
e Windows® NT | 3.0

and

* GeneMapper® ID-X
Software v1.0.1 or higher

e Windows 2000

Note: We conducted validation studies for the AmpF(STR® Identifiler® PCR
Amplification Kit using the 310 Genetic Analyzer running Mac OS®. This
configuration is now obsolete.

About Applied Biosystems fluorescent multi-color dye technology allows the analysis of
multicomponent multiple loci, including loci that have alleles with overlapping size ranges. Alleles for
analysis overlapping loci are distinguished by labeling locus-specific primers with different

colored dyes.

Multicomponent analysis is the process that separates the five different fluorescent dye
colors into distinct spectral components. The four dyes used in the Identifiler® Kit to
label samples are 6-FAM™, VIC®, NED™, and PET® dyes. The fifth dye, LIZ®, is used
to label the GeneScan™ 500 LIZ® Size Standard or the GeneScan™ 600 LIZ® Size
Standard v2.0.

16 AmpFISTR® Identifiler® PCR Amplification Kit User Guide



Chapter 1 Overview 1
Instrument and software overview

How Each of these fluorescent dyes emits its maximum fluorescence at a different
multicomponent wavelength. During data collection on the Applied Biosystems instruments, the
fluorescence signals are separated by diffraction grating according to their
wavelengths and projected onto a charge-coupled device (CCD) camera in a
predictably spaced pattern. The 6-FAM " dye emits at the shortest wavelength and it is
displayed as blue, followed by the VIC® dye (green), NED"" dye (yellow), PET® dye
(red), and LIZ® dye (orange).

analysis works

Although each of these dyes emits its maximum fluorescence at a different
wavelength, there is some overlap in the emission spectra between the dyes (Figure 3).
The goal of multicomponent analysis is to correct for spectral overlap.

Figure 3 Emission spectra of the five dyes used in the AmpF{(STR® Identifiler® Kit
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Materials and equipment

Materials and equipment

Kit contents and The AmpF(STR® Identifiler® PCR Amplification Kit (Part no. 4322288) contains
storage materials sufficient to perform 200 amplifications at 25 uL/amplification.

IMPORTANT! The fluorescent dyes attached to the primers are light sensitive. Protect
the primer set, amplified DNA, allelic ladder, and size standard from light when not in
use. Keep freeze-thaw cycles to a minimum.

Component Description 200X Volume Storage
AmpFlSTR® PCR Contains MgCl,, deoxynucleotide 2 tubes, 1.1 mL | -15 to -25°C on receipt,
Reaction Mix triphosphates, and bovine serum albuminin | each 2 to 8°C after initial use

buffer with 0.05% sodium azide.

AmpF(STR® Identifiler® | Contains fluorescently labeled primers and | 1 tube, 1.1 mL
Primer Set non-labeled primers.

AmpF(STR® Identifiler® | Contains amplified alleles. 1 tube, 0.05 mL
Allelic Ladder

See Table 1 on page 12 for a list of alleles
included in the allelic ladder.

AmpliTag Gold® DNA Contains enzyme, with an activity of 5 U/pL. | 2 tubes, -15 to -25°C
Polymerase 0.05 mL/tube

AmpF(STR® Control Contains 0.10 ng/uL human female 9947A 1tube, 0.3mL | 2to 8°C
DNA 9947A DNA in 0.05% sodium azide and bufferT.

See Table 1 on page 12 for profile.

t+ The AmpF(STR® Control DNA 9947A is included at a concentration appropriate to its intended use as an amplification control (i.e., to provide
confirmation of the capability of the kit reagents to generate a profile of expected genotype). The AmpF(STR® Control DNA 9947A is not
designed to be used as a DNA quantitation control, and you may see variation from the labelled concentration when quantitating aliquots of
the AmpF(STR® Control DNA 9947A.

Standards for For the Identifiler® Kit, the panel of standards needed for PCR amplification, PCR
samples product sizing, and genotyping are:

e AmpF/STR® Control DNA 9947A - A positive control for evaluating the
efficiency of the amplification step and STR genotyping using the AmpF/(STR®
Identifiler® Allelic Ladder.

e GeneScan"" 500 LIZ® Size Standard or GeneScan™" 600 LIZ® Size Standard
v2.0 — Used for obtaining sizing results. These standards, which have been
evaluated as internal size standards, yield precise sizing results for Identifiler®
Kit PCR products. Order the GeneScan"" 500 LIZ® Size Standard
(Part no. 4322682) or the GeneScan"" 600 LIZ® Size Standard v2.0
(Part no. 4408399) separately.

e AmpF(STR® Identifiler® Allelic Ladder — Allelic ladder developed by Life
Technologies for accurate characterization of the alleles amplified by the
Identifiler® Kit. The AmpF(STR® Identifiler® Allelic Ladder contains most of the
alleles reported for the 15 autosomal loci. Refer to Table 1 on page 12 for a list of
the alleles included in the AmpF(STR® Identifiler® Allelic Ladder.

18 AmpFISTR® Identifiler® PCR Amplification Kit User Guide
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Required user-supplied reagents

In addition to the Identifiler® Kit reagents, the use of low-TE buffer (10 mM Tris,
0.1 mM EDTA, pH 8.0) is recommended. You can prepare the buffer as described in the
procedure below or order it from Teknova (Cat # T0223).

To prepare low-TE buffer:
1. Mix together:
e 10mL of 1 M Tris-HCI, pH 8.0
e 0.2mL of 0.5 M EDTA, pH 8.0
* 990 mL glass-distilled or deionized water

Note: Adjust the volumes accordingly for specific needs.
2. Aliquot and autoclave the solutions.

3. Store at room temperature.

DNA gquantification

Importa nce of Quantifying the amount of DNA in a sample before amplification allows you to

quantification determine whether or not sufficient DNA is present to permit amplification and to
calculate the optimum amount of DNA to add to the reaction. The optimum amount of
DNA for the Identifiler® Kit is 1.0 ng in a maximum input volume of 10 uL for 28 PCR
cycles.

AmpFISTR® [dentifiler® PCR Amplification Kit User Guide 19



Chapter 2 Perform PCR
DNA quantification

If too much DNA is added to the PCR reaction, then the increased amount of PCR
product that is generated can result in:

* Fluorescence intensity that exceeds the linear dynamic range for detection by the

instrument (“off-scale” data). Off-scale data are problematic because:

— Quantitation (peak height and area) for off-scale peaks is not accurate. For
example, an allele peak that is off-scale can cause the corresponding stutter
peak to appear higher in relative intensity, thus increasing the calculated
percent stutter.

— Multicomponent analysis of off-scale data is not accurate, and it results in
poor spectral separation (“pull-up”).

¢ Incomplete A-nucleotide addition.

When the total number of allele copies added to the PCR is extremely low, allelic
dropout can occur resulting in a partial profile.

Methods of
quantifying DNA

Life Technologies provides several kits for quantifying DNA in samples. See the
references cited in the following table for details about these Kkits.

Product

Description

Quantifiler® Human DNA
Quantification Kit
(Part no. 4343895)

and

Quantifiler® Y Human Male
DNA Quantification Kit
(Part no. 4343906)

For more information, see
Quantifiler® Human DNA
Quantification Kits User’s Manual
(Pub. no. 4344790)

Quantifiler® Duo DNA
Quantification Kit
(Part no. 4387746)

For more information, see
Quantifiler® Duo DNA
Quantification Kit User's Manual
(Pub. n0.4391294)

Properties:

The Quantifiler® Human and Quantifiler® Y Human Male Kits are highly specific for
human DNA, and they individually detect total human or male DNA, respectively. The
kits detect single-stranded and degraded DNA.

How they work:

The Quantifiler® DNA Quantification Kits consist of target-specific and internal control
5" nuclease assays.

The Quantifiler® Human and Quantifiler® Y Human Male Kits contain different target-
specific assays [human DNA or human male DNA, respectively] that each consist of two
locus-specific PCR primers and one TagMan® MGB probe labeled with FAM™ dye for
detecting the amplified sequence. The kits each contain a separate internal PCR control
(IPC) assay, which consists of an IPC template DNA (a synthetic sequence not found in
nature), two primers for amplifying the IPC template, and one TagMan® MGB probe
labeled with VIC® dye for detecting the amplified IPC.

Properties:

The Quantifiler® Duo Kit is highly specific for human DNA. This kit combines the
detection of both total human and male DNA in one PCR reaction.The kit detects single-
stranded and degraded DNA.

How it works:

The Quantifiler® Duo DNA Quantification Kit consists of target-specific and internal
control 5' nuclease assays.

The Quantifiler® Duo kit combines two human-specific assays in one PCR reaction (for
total human DNA and human male DNAJ. The two human DNA specific assays each
consist of two PCR primers and a TagMan® probe. The TagMan® probes for the human
DNA and human male DNA assays are labeled with VIC® and FAM™ dyes, respectively.
In addition, the kit contains an internal PCR control (IPC) assay similar in principle to
that used in the other Quantifiler kits, but labeled with NED™ dye.
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Prepare the amplification kit reactions

Prepare the amplification kit reactions

1. Calculate the volume of each component needed to prepare the reactions, using
the table below.

DNA sample Volume per reaction
AmpF(STR® PCR Reaction Mix 10.5 pL
AmpliTag Gold® DNA Polymerase 0.5 pL
AmpF(STR® Identifiler® Primer Set 5.5 uL

Note: The volumes indicated above include a slight overfill to account for the loss
that occurs during reagent transfers.

2. Prepare reagents. Thaw the PCR Reaction Mix and the Identifiler® Primer Set,
then vortex all reagent tubes, including the enzyme, for 3 seconds and centrifuge
briefly before opening the tubes.

IMPORTANT! Thawing is required only during first use of the Primer Set and PCR
Reaction Mix. After first use, these reagents are stored at 2 to 8°C and do not
require subsequent thawing. Do not refreeze these reagents.

3. Prepare the master mix: Pipette the required volumes of components into an
appropriately sized polypropylene tube.

4, Vortex the master mix for 3 seconds, then centrifuge briefly.

5. Dispense 15 uL of the reaction mix into each reaction well of a MicroAmp®
Optical 96-Well Reaction Plate or each MicroAmp® tube.

6. Prepare the DNA samples:

DNA sample To prepare...

Negative control | Add 10 pL of low-TE buffer (10mM Tris, 0.1mM EDTA, pH 8.0).

Test sample Dilute a portion of the test DNA sample with low-TE buffer so
that 1.0 ng of total DNA is in a final volume of 10 uL. Add 10 pL
of the diluted sample to the reaction mix.

Positive control Add 10 pL of 9947A control DNA (0.1 ng/pL).

The final reaction volume (sample or control plus master mix) is 25 pL.

7. Seal the plate with MicroAmp® Clear Adhesive Film or MicroAmp® Optical
Adhesive Film, or cap the tubes.

8. Centrifuge the tubes at 3000 rpm for about 20 seconds in a tabletop centrifuge
(with plate holders if using 96-well plates).

9. Amplify the samples in a GeneAmp® PCR System 9700 with the silver or
gold-plated silver 96-well blocks or a Veriti® 96-Well Thermal Cycler.

Note: The Identifiler® Kit is not validated for use with the GeneAmp PCR System
9700 with the aluminium 96-well block. Use of this thermal cycling platform may
adversely affect performance of the Identifiler® Kit.
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Perform PCR

1. Program the thermal cycling conditions:

* When using the GeneAmp PCR System 9700 with either 96-well silver or
gold-plated silver block, select the 9600 Emulation Mode.

e When using the Veriti® 96-Well Thermal Cycler, refer to the following
document for instructions on how to configure the Veriti instrument to run
in the 9600 Emulation Mode: User Bulletin: Veriti® 96-Well Thermal Cycler
AmpF(STR® Kit Validation (Pub. no.4440754).

Initial Denature Anneal Extend Final Final hold
incubation step extension

HOLD CYCLE (28) HOLD HOLD

95°C 94°C 59°C 72°C 60°C 4-25°C

11 min 1 min Tmin Tmin 60 min oo

2. Load the plate into the thermal cycler and close the heated cover.

IMPORTANT! If using the 9700 thermal cycler with silver or gold-plated silver
block and adhesive clear film instead of caps to seal the plate wells, be sure to
place a MicroAmp® compression pad (Part no. 4312639) on top of the plate to
prevent evaporation during thermal cycling. The Veriti® Thermal Cycler does not
require a compression pad.

3. Start the run.

4. On completion of the run, store the amplified DNA and protect from light.

If you are storing the DNA... Then place at...
< 2 weeks 2 to 8°C
> 2 weeks -15t0 -25°C

IMPORTANT! Store the amplified products so that they are protected from light.

Amplification using bloodstained FTA® cards

22

FTA® cards can be useful for collecting, storing, and processing biological samples. A
small punch disc of the card containing the sample can be placed directly into an
amplification tube, purified, and amplified, without transferring the disc. Our studies
indicate that a 1.2-mm bloodstained disc contains approximately 5-20 ng DNA. An
appropriate cycle number for this high quantity of DNA is 25 cycles as determined by
our validation studies. However, it is recommended that each laboratory determine
the optimum cycle number based on internal validation studies.

In the example shown in Figure 4, a 1.2-mm disc of a bloodstained FTA card was
purified using three washes with FTA Purification Reagent and two washes with

1X low-TE bulffer. The purified punch disc was then amplified in the MicroAmp® tube
for 25 cycles.
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Figure 4 AmpF(STR® Identifiler® Kit PCR Amplification Kit results from a 1.2-mm FTA bloodstain disc (25-cycle
amplification), analyzed on the Applied Biosystems 3130x! Genetic Analyzer
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Allelic ladder requirements

To accurately genotype samples, you must run an allelic ladder sample along with the
unknown samples.

Number of allelic . _Ong Number of samples per
Instrument injection .
ladders to run allelic ladderl(s)
equals

3100-Avant or 3130 | 1 per 4 injections 4 samples 15 samples + 1 allelic ladder
3100 or 3130x( 1 per injection 16 samples | 15 samples + 1 allelic ladder
3500 1 per 3 injections 8 samples 23 samples + 1 allelic ladder
3500xL 1 per injection 24 samples | 23 samples + 1 allelic ladder
310 1 per 10 injections | 1sample 9 samples + 1 allelic ladder

IMPORTANT! Variation in laboratory temperature can cause changes in fragment
migration speed and sizing variation between both single- and multiple-capillary runs
(with larger size variations seen between samples injected in multiple-capillary runs).
We recommend the above frequency of allelic ladder injections, which should account
for normal variation in run speed. However, during internal validation studies, verify
the required allelic ladder injection frequency to ensure accurate genotyping of all
samples in your laboratory environment.
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Allelic ladder requirements

It is critical to genotype using an allelic ladder run under the same conditions as the
samples because size values obtained for the same sample can differ between
instrument platforms because of different polymer matrices and electrophoretic
conditions.
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Section 3.1 3100/3100-Avant and 3130/3130xl instruments
Set up the 3100/3100-Avant or 3130/3130x! instrument for electrophoresis

Section 3.1 3100/3100-Avant and 3130/3130x!
instruments

Set up the 3100/3100-Avant or 3130/3130x! instrument for
electrophoresis

“Ordering Information” on page 121 lists the required materials not supplied with the

Reagents and parts
AmpFlSTR® Identifiler® PCR Amplification Kit.

IMPORTANT! The fluorescent dyes attached to the primers are light sensitive. Protect
the primer set, amplified DNA, allelic ladder, and size standard from light when not in
use. Keep freeze-thaw cycles to a minimum.
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The following table lists Data Collection Software and the run modules that can be
used to analyze Identifiler® Kit PCR products. For details on the procedures, refer to
the documents listed in the table.

Electrophoresis
software setup and

reference
documents
Genetic Data Operatin
Collection P 9 Run modules and conditions References
Analyzer System
Software
Applied 3.0 Windows® e HIDFragmentAnalysis36_POP4_1  Applied Biosystems 3130/3130x!
Biosystems XP Injection conditions: Genetic Analyzers Using Data
3130/3130x( ~ 3130 = 3 kV/5 sec Collection Software v3.0, Protocols for
Processing AmpFSTR® PCR
- 3130x( = 3 kV/10 sec Amplification Kit PCR Products User
e Dye Set G5 Bulletin (Pub. no. 4363787)
3100 2.0 Windows® e HIDFragmentAnalysis36_POP4_1  3100/3100-Avant Genetic Analyzers
2000 Injection condition: 3kV/10 sec Using Data Collection Software v2.0,
e Dve Set G5 Protocols for Processing AmpF(STR®
Y PCR Amplification Kit PCR Products
User Bulletin (Pub. no. 4350218)
1.1 Windows® | e GeneScan3évb_DyeSetG5Module 3100/3100-Avant Genetic Analyzers
NT Injection condition: 3kV/10 sec Protocols for Processing AmpFISTR®
R . PCR Amplification Kit PCR Products
G5600v2.0Analysis.gsp User Bulletin [Pub. no. 4332345)
3100-Avant 1.0 Windows® e GeneScan3éAvb_DyeSetG5Module  3700/3100-Avant Genetic Analyzers
NT Injection condition: 3 kV/5sec Protocols for Processing AmpF(STR®
. . PCR Amplification Kit PCR Products
G5600v2.0Analysis.gsp User Bulletin [Pub. no. 4332345)
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Prepare samples for electrophoresis on the 3100/3100-Avant or 3130/3130x! instrument

Prepare samples for electrophoresis on the 3100/3100-Avant or
3130/3130x! instrument

28

Prepare the samples for electrophoresis immediately before loading.

1.

Calculate the volume of Hi-Di"" Formamide and size standard needed to prepare
the samples:

e © ® =2 o

Reagent Volume_ per Reagent Volume_ per
reaction reaction
GeneScan™ 500 0.3 L OR GeneScan™ 600 05 uL
LIZ® Size Standard LIZ® Size Standard
v2.0
Hi-Di™" Formamide 8.7 uL Hi-Di"™ Formamide 8.5 uL

Note: Include additional samples in your calculations to provide excess volume
for the loss that occurs during reagent transfers.

IMPORTANT! The volume of size standard indicated in the table is a suggested
amount. Determine the appropriate amount of size standard based on your
experiments and results.

Pipette the required volumes of components into an appropriately sized
polypropylene tube.

Vortex the tube, then centrifuge briefly.
Into each well of a MicroAmp® Optical 96-Well Reaction Plate, add:

* 9 uL of the formamide:size standard mixture
¢ 1 pL of PCR product or allelic ladder
Note: For blank wells, add 10 pL of Hi-Di"" Formamide.

Seal the reaction plate with appropriate septa, then centrifuge the plate to ensure
that the contents of each well are collected at the bottom.

Heat the reaction plate in a thermal cycler for 3 minutes at 95°C.
Immediately place the plate on ice for 3 minutes.

Prepare the plate assembly, then place on the autosampler.

Ensure that a plate record is completed and link the plate record to the plate.

Start the electrophoresis run.
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Set up the 3500/3500xL instrument for electrophoresis

Section 3.2 3500/3500xL Series instruments

Set up the 3500/3500xL instrument for electrophoresis

Reagents and parts  “Ordering Information” on page 121 lists the required materials not supplied with the
AmpF(STR® Identifiler® PCR Amplification Kit.

IMPORTANT! The fluorescent dyes attached to the primers are light sensitive. Protect
the primer set, amplified DNA, allelic ladder, and size standard from light when not in
use. Keep freeze-thaw cycles to a minimum.
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Electrophoresis The following table lists Data Collection Software and the run modules that can be
software setup and used to analyze Identifiler® Kit PCR products. For details on the procedures, refer to
the documents listed in the table.

reference
documents
Genetic Data Operatin
Collection P 9 Run modules and conditions References
Analyzer System
Software
Applied 3500 Data =~ Windows® e HID36_POP4 Applied Biosystems 3500/3500xL
Biosystems Collection XP Injection conditions: 1.2kV/15 sec Genetic Analyzer User Guide
3500 Software (Pub. no. 4401661)
1.0 or e Dye Set G5
Applied Windows « HID36_POP4 Appl/ed Biosystems 3500 and 3500xL
Biosystems Vista © Injection conditions: 1.2kV/24 sec Genetic Analyzers Quick Reference
3500 ! o Card (Pub. no. 4401662)
e Dye Set G5

Prepare samples for electrophoresis on the 3500/3500xL
instrument

Prepare the samples for electrophoresis immediately before loading.

1. Calculate the volume of Hi-Di™ Formamide and GeneScan™ 600 LIZ® Size
Standard v2.0 needed to prepare the samples:

Reagent Volume per reaction
GeneScan™ 600 LIZ® Size Standard v2.0 0.5 uL
Hi-Di™ Formamide 8.5 L

Note: Include additional samples in your calculations to provide excess volume
for the loss that occurs during reagent transfers.

IMPORTANT! The volume of size standard indicated in the table is a suggested
amount. Determine the appropriate amount of size standard based on your
results and experiments.
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Prepare samples for electrophoresis on the 3500/3500xL instrument

e © ®©® =2 o

Pipette the required volumes of components into an appropriately sized
polypropylene tube.

Vortex the tube, then centrifuge briefly.

Into each well of a MicroAmp® Optical 96-Well Reaction Plate, or each
MicroAmp® optical strip tube, add:

* 9 uL of the formamide:size standard mixture
* 1 uL of PCR product or allelic ladder
Note: For blank wells, add 10 pL of Hi-Di"" Formamide.

Seal the reaction plate or strip tubes with the appropriate septa, then centrifuge to
ensure that the contents of each well are collected at the bottom.

Heat the reaction plate or strip tubes in a thermal cycler for 3 minutes at 95°C.
Immediately put the plate or strip tubes on ice for 3 minutes.

Prepare the plate assembly, then place on the autosampler.

Ensure that a plate record is completed and link the plate record to the plate.

Start the electrophoresis run.
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Set up the 310 instrument for electrophoresis

Section 3.3 310 Instrument

Set up the 310 instrument for electrophoresis

Reagents and parts  “Ordering Information” on page 121 lists the required materials not supplied with the
AmpF(STR® Identifiler® PCR Amplification Kit.

IMPORTANT! The fluorescent dyes attached to the primers are light sensitive. Protect
the primer set, amplified DNA, allelic ladder, and size standard from light when not in
use. Keep freeze-thaw cycles to a minimum.
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Electrophoresis The following table lists Data Collection Software and the run modules that can be
software setup and used to analyze Identifiler® Kit PCR products. For details on the procedures, refer to
the documents listed in the table.

reference
documents
Data Operatin
Collection P 9 Run modules and conditions References
System
Software
317 Windows XP e GS STR POP4 (1mL]) G5 v2.md5 = 370 Genetic Analyzer User’s Manual (Windows)
or or Injection condition: (Pub. no. 4317588)
3.0t Windows® 15 kV/5 sec 310 Protocols for Processing AmpFISTR® PCR
NT and Amplification Kit Products with Microsoft Windows
Windows NT Operating System: User Bulletin
2000 (Pub. no. 4341742)

+ We conducted concordance studies for the Identifiler® Kit using this configuration.

Prepare samples for electrophoresis on the 310 instrument

Prepare the samples for electrophoresis immediately before loading.

1. Calculate the volume of Hi-Di"" Formamide and size standard needed to prepare
the samples:

Reagent Volume per reaction
GeneScan™ 500 LIZ® Size Standard or 0.75 pL
GeneScan™ 600 LIZ® Size Standard v2.0
Hi-Di"™ Formamide 24.5 ul

Note: Include additional samples in your calculations to provide excess volume
for the loss that occurs during reagent transfers.
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Prepare samples for electrophoresis on the 310 instrument

IMPORTANT! The volume of size standard indicated in the table is a suggested
amount. Determine the appropriate amount of size standard based on your
results and experiments.

2. Pipette the required volumes of components into an appropriately sized
polypropylene tube.

3. Vortex the tube, then centrifuge briefly.

4. Into each 0.2 mL sample tube, add:
® 25 uL of the formamide:size standard mixture
e 1.5 pL of PCR product or allelic ladder
Note: For blank wells, add 25 pL of Hi-Di"™ Formamide.

5. Seal the tubes with the appropriate septa, then briefly centrifuge to ensure that
the contents of each tube are mixed and collected at the bottom.

Heat the tubes in a thermal cycler for 3 minutes at 95°C.
Immediately place the tubes on ice for 3 minutes.
Place the sample tray on the autosampler.

Ensure that an injection list is prepared.

© 0 ©® = o

Start the electrophoresis run.
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Section 4.1 GeneMapper® ID Software

Overview of GeneMapper® /D Software

GeneMapper® ID Software is an automated genotyping software for forensic
casework, databasing, and paternity data analysis.

After electrophoresis, the data collection software stores information for each sample
in a .fsa file. Using GeneMapper® ID Software v3.2.1 software, you can then analyze
and interpret the data from the .fsa files.

Instruments Refer to “Instrument and software overview” on page 16 for a list of compatible
instruments.
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Set up GeneMapper® ID Software for data analysis

Before you start

When using GeneMapper® ID Software v3.2.1 to perform human identification (HID)
analysis with AmpF(STR® kits, be aware that:

HID analysis requires at least one allelic ladder sample per run folder. Your
laboratory can use multiple ladder samples in an analysis, provided individual
laboratories conduct the appropriate validation studies.

For multiple ladder samples, the GeneMapper® ID Software calculates allelic bin
offsets by using an average of all ladders that use the same panel within a run
folder.

Allelic ladder samples in an individual run folder are considered to be from a
single run.

When the software imports multiple run folders into a project, only the ladder(s)
within their respective run folders are used for calculating allelic bin offsets and
subsequent genotyping.

Allelic ladder samples must be labeled as “Allelic Ladder” in the Sample Type
column in a project. Failure to apply this setting for ladder samples results in
failed analysis.

Injections containing the allelic ladder must be analyzed with the same analysis
method and parameter values that are used for samples to ensure proper allele
calling.

Alleles that are not in the AmpF(STR® Allelic Ladders do exist. Off-ladder (OL)
alleles may contain full and/or partial repeat units. An off-ladder allele is an allele
that occurs outside the +0.5-nt bin window of any known allelic ladder allele or
virtual bin.

Note: If a sample allele peak is called as an off-ladder allele, the sample result
needs to be verified according to the laboratory’s protocol.

Set up GeneMapper® ID Software for data analysis

File names

Before using the
software for the
first time

34

The file names shown in this section may differ from the file names you see when you
download or import files. If you need help determining the correct files to use, contact
your local Life Technologies Human Identification representative, or go to
www.lifetechnologies.com/support » Software, Patches & Updates » GeneMapper®
ID Software.

Before you can analyze sample (.fsa) files using GeneMapper® ID Software v3.2.1 for
the first time, you need to:

Import panels and bins into the Panel Manager, as explained in “Import panels
and bins” on page 35.

Create an analysis method, as explained in, “Create an analysis method” on page
39.

Create a size standard, as explained in “Create size standard” on page 44.

Define custom views of analysis tables.

Refer to Chapter 1 of the GeneMapper® ID Software Versions 3.1 and 3.2 Human
Identification Analysis Tutorial (Pub. no. 4335523) for more information.

Define custom views of plots.

Refer to Chapter 1 of the GeneMapper® ID Software Versions 3.1 and 3.2 Human
Identification Analysis Tutorial (Pub. no. 4335523) for more information.
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Set up GeneMapper® ID Software for data analysis

Import panels and To import the Identifiler® panel and bin set into the GeneMapper® ID Software v3.2.1
bins database:

1. Start the GeneMapper® ID Software, then log in with the appropriate user name
and password.

IMPORTANT! If you need logon instructions, refer to page 2-7 of the GeneMapper®
ID Software Version 3.1 Human ldentification Analysis User Guide (Pub. no. 4338775).

2. Select Tools » Panel Manager.

3. Find, then open the folder containing the panels and bins:

a. Select Panel Manager in the navigation pane.

[#)Panel Manager
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File Edit Eins Wiew %

=5 NN NN Il

== Panel WManager

Highlight this.
|

b. Select File » Import Panels to open the Import Panels dialog box.

c. Navigate to, then open the x:\ Applied Biosystems\ GeneMapper \ Panels
folder, where x is the drive on which the GeneMapper® ID Software is

installed.

4. Select AmpFLSTR_Panels_v2.txt, then click Import.

Note: Importing this file creates a new folder in the navigation pane of the Panel
Manager, AmpFLSTR_Panels_v2. This folder contains the panels and associated

markers.

Import Panels |

-l BaEE

AmpFISTR_Yfiler_Bin_v
AmpFISTR _Yfiler_Panel_w2 b=t

File: natme: IAmpFLSTR_PaneIs_VE.bd Irmport |
Files of type: IAIIFiIes LI Cancel |

5. Import AmpFLSTR_Bins_v2.txt:
a. Select the AmpFLSTR_Panels_v2 folder in the navigation pane.
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[#.Panel Manager
File Edit Bins ‘fiew

> || 8 || | o

== Panel Manager Pane:
W AmpFLSTR_Panclz 2 R ILIg

b. Select File » Import Bin Set to open the Import Bin Set dialog box.

c. Navigate to, then open the x:\ Applied Biosystems\ GeneMapper\ Panels
folder.

d. Select AmpFLSTR_Bins_v2.txt, then click Import.

Note: Importing this file associates the bin set with the panels in the
AmpFLSTR_Panels_v2 folder.

(@) Import Bin Set x|

Look in: I[:I Panelz j ﬁ

AMpFLSTR_Panels_v2 b
AmpFISTR Y filer_Bin_w2 txt
AmpFISTR VY filer _Panel 2 tx

File name: IAmpFLSTR_Bins_VQ.bd Import |
Files of fype: IA” Files LI Cancel |

6. View the imported panels in the navigation pane:
a. Double-click the AmpFLSTR_Panels_v2 folder.
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b. Double-click the Identifiler_v2 folder to display the panel information in the
right pane and the markers below it.

[®)Panel Manager
File Edit Bins ‘iew

ik X | | |E & K | | .l m | |Bin Set: IAmpFLSTR_EiinS_VQ - | | B W
E-SIParel Manager Baker Hume | Dye Color | Min Sime |[Max Size | Cortrol Alleles
E—ﬁ AmpFLSTR_Panelz_v2 |1 3511749 | e 1180 1835 13 g)
CJBlue_vz 2 [D2sn bue 1845  [2475 |30 3
|jere._an_|_v2 3 |DTSE20 b [2510  |2985 10,11 =
CTProfiler_v2 [
CPrafiier Plus_v2 4 |CSFIPO bue  [30242 |34863 1042 3
Ccofiler_va 5 |D3st3ss green 380 1480 1445 9;@
CI5EM_Plus w2 g |THO1 green 1580 |2050 (843 5
e 7 |Di3sHT green 20565 (25046 |11 ps
— DES1179 &
I— & |D163539 green  |2553 30181 1142 g
— D7sE20 0 |D2si3ss green  |3045 (3703 19,23 S
— CSF1PO 10 |D195433 yellowe (1010 1460 1415 S
B ?Sg: =8 11 v, yellowe 1510 [2135 1748
| D13s317 12 [TPOX yellowe |21689 [26083 |8
— D1ES530 13 018551 yellowe  |26443 (3500 15489
[ D2s1338 14 | AMEL red 1060 (1140 |x
_D1 98433 Aar IRESOd O el A5 M ASm M A4

7. View the markers and display the Bin view in the navigation pane:

a. Select the AmpFLSTR_Panels_v2 folder to display its list of kits in the right
pane.

b. Double-click the Identifiler_v2 folder to display its list of markers below it.
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c. Select D8S1179 to display the Bin view for the marker in the right pane.

[®]Panel Manager
il

File Edit Bins ‘iew

x|

[E-EdPanel Manager
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H:118.33 ¥ 0.49 Marker: 0851179 (118.00-183.50)

O Cancel | Agpaly |
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8. Click Apply, then OK to add the AmpF(STR® panel and bin set to the
GeneMapper® ID Software database.

IMPORTANT! If you close the Panel Manager without clicking OK, the panels and

bins are not imported into the GeneMapper® ID Software database.
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Create an analysis  The HID Advanced analysis method for the Identifiler® Kit uses the
method AmpFLSTR_Bins_v?2 file described in step 5 on page 35.

Use the following procedure to create a HID analysis method for the Identifiler® Kit.

1. Select Tools » GeneMapper Manager to open the GeneMapper Manager.

_5_; GeneMapper Manager X

Projects Analysis Methods I Table Settings | Plot Seﬂingsl Matricesl Size Standards

Mame Last Saved Cavner Instrument Analysis Type Dezcrip
HID_&cvanced 2008-06-18 16:22:2 | gnicd HIC -
HID_Classic 2007-08-06 10:03:0 | gnicd HIC

Microzatellite Defaut 2004-05-28 11:34:3 | grnid Microzastelite Factary _

)
()
>
()
=
[
O
O
g
<)
O
(9]
o
=
=
(V)
=
()

2. Select the Analysis Methods tab, then click New to open the New Analysis
Method dialog box.

3. Select HID and click OK to open the Analysis Method Editor with the General
Tab selected.

4. Enter the settings in each tab of the Analysis Method Editor as shown in the
figures below unless the instructions state otherwise.

Note: The Analysis Method Editor closes when you save your settings. To
complete this step quickly, do not save the analysis method until you finish
entering settings in all of the tabs.

5. After you enter settings in all tabs, click Save.

AmpFISTR® [dentifiler® PCR Amplification Kit User Guide 39



4 Chapter 4 Analyze Data
Set up GeneMapper® ID Software for data analysis

General tab
settings aAnalysis Method Editor - HID

Ider‘difiIer_AnaIysisMethod_ﬂ|

In the Name field, either type the name as shown, or enter a name of your choosing.
The Description and Instrument fields are optional.
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Allele tab settings
x

General  Allele | Peak Detectorl Peak G‘eualityl Quality Flagsl

(=Ia1=i P LS TR _Bine_v
v Use marker-specific stutter ratio if arvailable
larker Repeat Type Tri Tetra Perta Hexa g
Cut-off Yalue oo oo oo oo <
Minus4, Retio fo.0 fo.0 fo.0 fo.0 Z
Minusa, Distance From |00 oo oo oo 8
To foo fo.0 fo.0 fo.0 e
Minus Stutter Ratio oo oo oo oo 8
Minus Stutter Distance  From  [0.0 f5.25 fo.0 fo.0 S
To oo s 75 oo oo 5
Plus Stutter Retio fo.0 fo.0 fo.0 fo.0 @
Plus Stutter Distance  From |00 oo oo oo
To foo fo.0 fo.0 fo.0
Amelogenin Cutoff IF

Range Filter... | Factory Defaults |

Ok | Cancel |

* In the Bin Set field, select the AmpFLSTR_Bins_v2 bin set imported previously
and configure the stutter distance parameters as shown.

* GeneMapper® ID Software v3.2.1 allows you to specify four types of marker
repeat motifs: tri, tetra, penta, and hexa. You can enter parameter values for each
type of repeat in the appropriate column.

* Specify the stutter ratio:
— To apply the stutter ratios listed in the Allele tab for single-source data,
deselect the “Use marker-specific stutter ratio if available” check box

(selected by default). Perform appropriate internal validation studies to
determine the appropriate filter setting to use.

Note: Applying global stutter ratios may reduce the editing required for
single-source sample data.

— To apply the stutter ratios contained in the AmpFLSTR_Panels_v2.txt file,
select the “Use marker-specific stutter ratio if available” check box (selected
by default). Perform appropriate internal validation studies to determine the
appropriate filter setting to use.
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Peak Detector tab
settings Analysis Method Editor - HID (X

General | &llele | Peak Detector | peak Quality | Quality Flags

Peak Detection Algorithm: [&dvanced w
Ranges Peak Detection
) . Perform
Analysis SIZIHQ Peak Amplitude Thresholds: internal
Full Range All Sizes b B: R: validation
[T studies to
G: o :
determine
¥ settings
—=moathing and Baselining
Min. Peak Half Wyidth: 2 pt=
Smoothing ) More _ 3
@ Light Palynomial Degree:
() Heawy Peak Wincow Size: 15 pts

Bazeline Windaw: | 51 pts =iope Threshoid
Peak Start: oo
—=ize Calling Methood Peak End: oo

() 2nd Order Least Sguares
{:} 3rd Order Least Squares
() Cubic Spline Interpolation
(3) Local Southern Method
() Global Southern Method

’ Factory Defaults l

(o | [ coment |

IMPORTANT! Perform the appropriate internal validation studies to determine the
peak amplitude thresholds for interpretation of Identifiler® Kit data.

Fields include:

* Peak amplitude thresholds — The software uses these parameters to specify the
minimum peak height, in order to limit the number of detected peaks. Although
GeneMapper® ID Software displays peaks that fall below the specified amplitude
in electropherograms, the software does not label or determine the genotype of

these peaks.

* Size calling method - The Identifiler® Kit has been validated using the Local
Southern sizing method. Before using other sizing methods, perform internal
validation studies.
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Peak Quality tab
settings T

General | Allele | Pesk Detector  Pesk Qualty | quaity Fiags |

. Perform

"Slgnal lewel internal
Homozygous min peak height I validation
Heterozygous min peak height I StUdleS.to
determine

"Heterozygote balance settings

Min pesk height ratio
N\

—Peak morphology

T

Max peak width (basepairs) 1.5
—Pull-up peak
Pull-ug ratio 0.05

)
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()
=
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—allele number

T

g expected alleles

Factory Defaults |

Ok, | Cancel |

IMPORTANT! Perform the appropriate internal validation studies to determine the
minimum heterozygous and homozygous minimum peak height thresholds and the
minimum peak height ratio threshold for interpretation of Identifiler® Kit data.
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Quality Flags tab

settings x

Generall Allelel Peak Detectorl Peak Gualty

Quality weights are between 0 and 1.
Guality Flag Settings

Spectral Pull-up & Cortral Cancardance |10
Broad Peak ’F Lowy Peak Height ,F
Out of Bin Allele s Off-scale s
Owerlap bs Peak Height Fatio b3

PoY Thresholds

Pazs Range:
Sizing Guality: From [0.75 tod1.0
Genotype Cuality: From |0.75 to1.0

Lowy Guality Range:

From0Oto  [025

FromoO0to  |0.23

Factory Defaults |

QK | Cancel |

IMPORTANT! The values shown are the software defaults and are the values we used
during developmental validation. Perform the appropriate internal validation studies
to determine the appropriate values for interpretation of Identifiler® Kit data.

Create size The size standards for the Identifiler® Kit use the following size standard peaks in

standard their definitions:

GeneScan™ 500 LIZ® Size Standard

GeneScan™ 600 LIZ® Size Standard v2.0

75, 100, 139, 150, 160, 200, 300, 340, 350, 400,
and 450

80, 100, 114, 120, 140, 160, 180, 200, 214, 220,
240, 250, 260, 280, 300, 314, 320, 340, 360,
380, 400, 414, 420, 440 and 460

Note: The 250-nt peak in the GeneScan™ 500 LIZ® Size Standard is not included in the
size standard definition. This peak can be used as an indicator of precision within a

run.

Use the following procedure to create the appropriate size standard:

1. Select Tools » GeneMapper Manager to open the GeneMapper Manager.
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2. Select the Size Standards tab, click New, select the Basic or Advanced radio
button, then click OK.

GeneMapper Manager il

Projects | Analysis Methods | Table Settings | Plot Settings | Matrices
|Name |Last Saved |Owner Type |Description
3PV _F_HID_GZ500 2004-05-28 11:34:3 | grnid Basic/Advanced Factory Provided  |*
CE_z5_HD_&S500 2004-05-28 11:34:3 | grnid Basic/Advanced Factary Provided
CE_F_HID_G=3500 2004-05-28 11:34:3 | grnid Basic/Advanced Factory Provided |

Dang

Meswy.... WEEML. SAVEIAE. Irrport.... Expart.. [elete |

3. Enter a name (for example, CE_G5_Identifiler_GS500 as shown below). In the Size
Standard Dye field, select Orange. In the Size Standard Table, enter the sizes
specified in on page 44. The example below is for the GeneScan™ 500 LIZ® Size

)
()
>
()
=
[
O
O
g
<)
O
(9]
o
=
=
(V)
=
()

Standard.
( x|
Edit
—Size Standard Description
arme: CE_Ga_ldentifiler G500
Description:
Size Standard Dye: IOrange LI

Size Standard Takle
Size in Bazepairs
1 5.0 |

2 1oono

3 1390

4 1500

5 1600

6 (2000

T 3000

g (3400

9 3500

10 (4000

11 (4500

AmpFISTR® [dentifiler® PCR Amplification Kit User Guide 45



4 Chapter 4 Analyze Data
Analyze and edit sample files with GeneMapper® ID Software

Analyze and edit sample files with GeneMapper® ID Software

1. In the Project window, select File » Add Samples to Project, then navigate to the
disk or directory containing the sample files.

2. Apply analysis settings to the samples in the project.

Parameter

Settings

Sample Type
Analysis Method

Panel

Size Standard

Select the sample type.

Identifiler_AnalysisMethod_v1 (or the name of the analysis
method you created)

Identifiler_v2

CE_G5_Identifiler_GS5007 (or the name of the size standard you
created)

+ The Identifiler® Kit was originally validated using the GeneScan™ 500 LIZ® Size Standard. If you use the
GeneScan™ 600 LIZ® Size Standard v2.0 as an alternative, perform the appropriate internal validation
studies to support the use of this size standard with the Identifiler® Kit.

Note: For more information about how the Size Caller works, refer to the
GeneScan® Analysis Software for the Windows® NT Operating System Overview of the
Analysis Parameters and Size Caller User Bulletin (Pub. no. 4335617).

3. Click B (Analyze), enter a name for the project (in the Save Project dialog box),
then click OK to start analysis.

¢ The status bar displays the progress of analysis:

— As a completion bar extending to the right with the percentage

indicated

— With text messages on the left

* The table displays the row of the sample currently being analyzed in green
(or red if analysis failed for the sample).

* The Genotypes tab becomes available after analysis (see the figure on the

next page).
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Examine and edit a project

Project window after analysis

{ |GeneMapper ID ¥3.2.1 - Identifiler_Example - gmid Is Logged In _-I_I =

File Edit Analysis Wiew Tools Help

&F = @]H% Cﬂ“ﬁj‘[ﬁﬁ J_|_[|| £l || [ ||TabIeSeﬂing:||IHIDTable le“,@ %Hm

[EHE3Project Samples | Gehatypes I
B[ Ticertifler Exarnple Status |Sample File Sample Marme Sample Type | Analysis Method Panel Size Standard
1 Allelic_Ladder_HO2 fza Allelic_Ladder Allelic Ladder | Identifiler_Analysishethod_w1 Identifiler_v2 CE_G5_HID_GS500(75-450
2 Allelic_Ladder_HO4 fza Allelic_Ladder Allelic Ladder | Identifiler_Analysishethod_w1 Identifiler_v2 CE_G5_HID_GS500(75-450 %
3 Allelic_Ladder_HOG fza Allelic_Ladder Allelic Ladder | Identifiler_Analysishethod_w1 Identifiler_v2 CE_G5_HID_GS500(75-450 (':D
4 Allelic_Ladder_HOS fza Allelic_Ladder Allelic Ladder | Identifiler_Analysishethod_w1 Identifiler_v2 CE_G5_HID_GS500(75-450 Z
5 Allelic_Ladder_H10 fza Allelic_Ladder Allelic Ladder | Identifiler_Analysishethod_w1 Identifiler_v2 CE_G5_HID_GS500(75-450 -8
3 Ithert_007_0 031 2ng_G01 fza Ichert_007_0 .03 2ng Satmple Ickertifiler_Analysistlethod_v1 Idertifiler_v2 CE_G5_HID_GS500(75-450 8
7 Ithert_007_0 031 2ng_G02 fza Ichert_007_0 .03 2ng Satmple Idertifiler_AnalysizMethod_v1 Idertifiler_v2 CE_G5_HID_GS500(75-450 ®
g Ithert_007_0 031 2ng_G03 fza Ichert_007_0 .03 2ng Satmple Ickertifiler_Analysistlethod_v1 Idertifiler_v2 CE_G5_HID_GS500(75-450 E
g Ithert_007_0 031 2ng_G04 Tz Ichert_007_0 .03 2ng Satmple Ickertifiler_Analysistlethod_v1 Idertifiler_v2 CE_G5_HID_GS500(75-450 COIJ
10 Ichert_007_0 OE25ng_FO1 fa Ichert_007_0 OE25ng Satmple Ickertifiler_Analysistlethod_v1 Ickertifiler_v2 CE_G5_HID_GS500(75-450 =4
11 Ichert_007_0 OE25ng_FO2 faa Ichert_007_0 OE25ng Satmple Ickertifiler_Analysistlethod_v1 Idertifiler_v2 CE_G5_HID_GS500(75-450 S
12 Ichert_007_0 OE25ng_FO3 faa Ichert_007_0 OE25ng Satmple Idertifiler_AnalysizMethod_v1 Idertifiler_v2 CE_G5_HID_GS500(75-450 @
13 Ichert_007_0 OE25ng_FO4 faa Ichert_007_0 OE25ng Satmple Ickertifiler_Analysistlethod_v1 Idertifiler_v2 CE_G5_HID_GS500(75-450
14 Ichert_007_0.125ng_EO1 faa Ichert_007_0.125ng Satmple Ickertifiler_Analysistlethod_v1 Idertifiler_v2 CE_G5_HID_GS500(75-450
15 Ichert_007_0.125ng_E02 faa Ichert_007_0.125ng Satmple Ickertifiler_Analysistlethod_v1 Idertifiler_v2 CE_G5_HID_GS500(75-450
16 Ichert_007_0.125ng_EO3 faa Ichert_007_0.125ng Satmple Ickertifiler_Analysistlethod_v1 Idertifiler_v2 CE_G5_HID_GS500(75-450
17 Ichert_007_0.125ng_E04 faa Ichert_007_0.125ng Satmple Ickertifiler_Analysistlethod_v1 Idertifiler_v2 CE_G5_HID_GS500(75-450
15 Ithert_007_0 25ng_D01 fea Ichert_007_0 25ng Satmple Ickertifiler_Analysistlethod_v1 Idertifiler_v2 CE_G5_HID_GS500(75-450
19 Ithert_007_0 25ng_D02 fea Ichert_007_0 25ng Satmple Ickertifiler_Analysistlethod_v1 Idertifiler_v2 CE_G5_HID_GS500(75-450
20 Ithert_007_0 25ng_D03 fea Ichert_007_0 25ng Satmple Ickertifiler_Analysistlethod_v1 Idertifiler_v2 CE_G5_HID_GS500(75-450
21 Ithert_007_0 25ng_Di04 fea Ichert_007_0 25ng Satmple Ickertifiler_Analysistlethod_v1 Idertifiler_v2 CE_G5_HID_GS500(75-450
22 Ident_007_0.5ng_C01 fea Ident_007_0.5ng Sample Identifiler_Analysistethod_v1 Identifiler_v2 CE_G5_HID_GS500(75-450
23 Ident_007_0.5ng_C02 fza Ident_007_0.5ng Sample Identifiler_Analysistethod_v1 Identifiler_v2 CE_G5_HID_GS500(75-450
24 Ident_007_0.5ng_C03 f2a Ident_007_0.5ng Sample Identifiler_Analysistethod_v1 Identifiler_v2 CE_G5_HID_GS500(75-450
25 Ident_007_0.5ng_C04 fza Ident_007_0.5ng Sample Identifiler_Analysistethod_v1 Identifiler_v2 CE_G5_HID_GS500(75-450
4 I I

For more information about any of these tasks, refer to the GeneMapper® ID Software
Version 3.1 Human Identification Analysis User Guide (Pub. no. 4338775).

Examine and edit a project

You can display electropherogram plots from the Samples and Genotypes tabs of the
Project window to examine the data. These procedures start with the Samples tab of
the Project window (assuming the analysis is complete).

For more information

For details about GeneMapper® ID Software features, allele filters, peak detection
algorithms, and project editing, refer to:

» GeneMapper® ID Software Versions 3.1 and 3.2 Human Identification Analysis Tutorial
(Pub. no. 4335523)

*  GeneMapper® ID Software Version 3.1 Human Identification Analysis User Guide (Pub.
no. 4338775)

e Installation Procedures and New Features for GeneMapper® ID Software Software
Version v3.2 User Bulletin (Pub. no. 4352543)
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Section 4.2 GeneMapper® ID-X Software

Overview of GeneMapper® ID-X Software

GeneMapper® ID-X Software is an automated genotyping software for forensic
casework, databasing, and paternity data analysis.

After electrophoresis, the data collection software stores information for each sample
in a .fsa file or a .hid file. Using GeneMapper® ID-X Software, you can then analyze
and interpret the data from .fsa files (GeneMapper® ID-X Software v1.0.1 or higher) or
hid files (GeneMapper® ID-X Software v1.2 or higher).

Instruments Refer to “Instrument and software overview” on page 16 for a list of compatible
instruments.
Before you start When using GeneMapper® ID-X Software v1.0.1 or higher to perform human

identification (HID) analysis with AmpF(STR® kits, be aware that:

48

HID analysis requires at least one allelic ladder sample per run folder. Your
laboratory can use multiple ladder samples in an analysis, provided individual
laboratories conduct the appropriate validation studies.

For multiple ladder samples, the GeneMapper® ID-X Software calculates allelic
bin offsets by using an average of all ladders that use the same panel within a run
folder.

Allelic ladder samples in an individual run folder are considered to be from a
single run.

When the software imports multiple run folders into a project, only the ladder(s)
within their respective run folders are used for calculating allelic bin offsets and
subsequent genotyping.

Allelic ladder samples must be labeled as “Allelic Ladder” in the Sample Type
column in a project. Failure to apply this setting for ladder samples results in
failed analysis.

Injections containing the allelic ladder must be analyzed with the same analysis
method and parameter values that are used for samples to ensure proper allele
calling.

Alleles that are not in the AmpF(STR® Allelic Ladders do exist. Off-ladder (OL)
alleles may contain full and/or partial repeat units. An off-ladder allele is an allele
that occurs outside the +0.5-nt bin window of any known allelic ladder allele or
virtual bin.

Note: If a sample allele peak is called as an off-ladder allele, the sample result
needs to be verified according to the laboratory’s protocol.
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Set up GeneMapper® ID-X Software for data analysis

Panel, bin, and The file names shown in this section may differ from the file names you see when you

stutter file version  download or import files. If you need help determining the correct files to use, contact
your local Life Technologies Human Identification representative, or go to
www.lifetechnologies.com/support » Software, Patches & Updates » GeneMapper®
ID-X Software.

The instructions and examples in this section refer to the latest version of panel, bin,
and stutter file available at the time of publication.

Before using the Before you use GeneMapper® ID-X Software (v1.0.1 or higher for .fsa files, v1.2 or
software for the higher for .hid files) to analyze data for the first time, you must do the following:

first time 1. Check the version of panel, bin, and stutter files installed with the GeneMapper®
ID-X Software as explained in “Check panel, bin, and stutter file version” below.

o
o)
>
o
<
Q
o
B
@
@
o
x
w
o)
=
3
2
)

2. Check www.lifetechnologies.com/support » Software, Patches &
Updates » GeneMapper® ID-X Software to determine if newer files are
available.

3. If updated files are available, download and import the files into the
GeneMapper® ID-X Software, as explained in “Import panels, bins, and marker
stutter” on page 50.

Note: When downloading new versions of analysis files, refer to the associated
Read Me file for details of changes between software file versions. If you have
validated previous file versions for data analysis, conduct the appropriate
internal verification studies before using new file versions for operational
analysis.

4. Create an analysis method, as explained in “Create an analysis method” on
page 55.

5. Define custom views of analysis tables.

Refer to Chapter 1 of the GeneMapper® ID-X Software Version 1.0 Getting Started
Guide (Pub. no. 4375574) for more information.

6. Define custom views of plots.

Refer to Chapter 1 of the GeneMapper® ID-X Software Version 1.0 Getting Started
Guide (Pub. no. 4375574) for more information.

For more For quick set up instructions, refer to the GeneMapper® ID-X Software Version 1.0 Getting
information Started Guide (Pub. no. 4375574).

For details about GeneMapper® ID-X Software features, refer to:
o GeneMapper® ID-X Software Version 1.0 Getting Started Guide (Pub. no. 4375574)
o GeneMapper® ID-X Software Version 1.0 Quick Reference Guide (Pub. no. 4375670)
o GeneMapper® ID-X Software Version 1.0 Reference Guide (Pub. no. 4375671)
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Check panel, bin, 1. Start the GeneMapper® ID-X Software, then log in with the appropriate user
and stutter file name and password.
version

IMPORTANT! For logon instructions, refer to the GeneMapper® ID-X Software
Version 1.0 Getting Started Guide (Pub. no. 4375574).

2. Select Tools » Panel Manager.

3. Check the version of files imported into the Panel Manager:

»* Panel Manager

a. Select Panel Manager in the navigation pane. Rl Edt Bins View Help

[ >"- atl ‘,I

E28 .=, Panel Manager

b. Expand the Panel Manager folder and any sub-
folders to identify the analysis file version already
installed for your kit choice.

4. Check the version of files available for import into the Panel Manager:

a. Select Panel Manager, then select File » Import Panels to open the Import
Panels dialog box.

b. Navigate to, then open the Panels folder and check the version of panel, bin,
and stutter files installed.

5. If newer versions are available on the website, download and import as described
below.

Import pa nels, To import the Identifiler® Kit panel, bin set, and marker stutter from our web site into
bins, and marker the GeneMapper® ID-X Software database:

stutter 1. Download and open the file containing panels, bins, and marker stutter:

a. Go to www.lifetechnologies.com/support » Software, Patches &
Updates » GeneMapper® ID-X Software. Download the file AmpFLSTR
Analysis Files GMIDX.

b. Unzip the file.

2. Start the GeneMapper® ID-X Software, then log in with the appropriate user
name and password.

IMPORTANT! For logon instructions, refer to the GeneMapper® ID-X Software
Version 1.0 Getting Started Guide (Pub. no. 4375574).

3. Select Tools » Panel Manager.

4. Find, then open the folder containing the panels, bins, and marker stutter:

a. Select Panel Manager in the navigation pane.

»* Panel Manager

b. Select File » Import Panels to open the Import
File Edit Bins Wiew Help

Panels dialog box.
O = T |

2% .=, Panel Manager

c. Navigate to, then open the AmpFLSTR Analysis
Files GMIDX folder that you unzipped in step 1
on page 50.

50 AmpFISTR® Identifiler® PCR Amplification Kit User Guide


www.lifetechnologies.com/support

Section 4.2 GeneMapper® ID-X Software
Set up GeneMapper® ID-X Software for data analysis

5. Select AmpFLSTR_Panels_v2X (or the version you installed), then click Import.

Note: Importing this file creates a new folder in the navigation pane of the Panel
Manager “Identifiler_v1.1X”. This folder contains the panel and associated
markers.

« Import Panels ®
v 2 EE

Look in: E AMpFLSTR. Analysis Files GMIDY

— H AMPELSTR_Bins_vz¥
o B

My Recent EIA - .

Documents | ] Reade_AmpFLSTR vz

Desktop

My Documents

-

My Computer

File: name:

(@)
(¢
=)
[©)
<
V)
©°
©
SE
&)
S
x
n
o
=5
b3
L
(0}

[ Irnpork ]

Cancel

|AmpFLSTR_Panels_v2x.txt |

Files of type: [ All Files |

6. Import AmpFLSTR_Bins_V2X.txt:
a. Select the AmpFLSTR_Panels_v2X folder in the navigation pane.

» Panel Manager.
File Edit Bins Wiew Help

WX (WO W et s e o i GH B E | @EEE

IE

E‘"'d%hpa”d Manager Pamel Harne Comromert.
[C3) AMpFLSTR_MGMSElect_vai 1 Cfiler w1, 1% ndll =)
%AWHSTR—NGM—VSK 7 |SEM_Plos_v1.1% rul
AmpFLSTR_Panels_w1¥
= = MiGI_SElect w2, 1% il
[ AmpFLSTR _Panels_vzx] 5 = -
4 |Idenkifiler _Plus_v1.1% ndll
- RICRA T A ol

b. Select File » Import Bin Set to open the Import Bin Set dialog box.

c. Navigate to, then open the AmpFLSTR Analysis Files GMIDX folder.
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d. Select AmpFLSTR_Bins_V2X.txt, then click Import.

Note: Importing this file associates the bin set with the panels in the
AmpFLSTR_Panels_v2X folder.

« Import Bin Set ®
Lok in; E AMpFLSTR. Analysis Files GMIDR v | 5 ,,’:"|| =

i) AmpFLSTR Bins_vex |
L] ArmpFLSTR Panels_vzx
My Recenk QI AmpFLSTR_Stutker_wZx
Locuments | P ReadMe_AmpFLSTR_w2X

8 jie

Desktop

@

My Documents

File name: |&mpFLSTR_Bins_v2X.bxt | [ import |

My Computer | Files of bype: |p||| Files v| Cancel

7. View the imported panels in the navigation pane:
a. Double-click the AmpFLSTR_Panels_v2X folder.

b. Double-click the Identifiler_v1.1X folder to display the panel information in
the right pane.

» Panel Manager
File Edit Bins ‘Wiew Help

' X O H O W™ enset:|amprstrEns_.. v | lii Ty Il B H HEBER

IE

=R d%b Panel Manager Pael Hame Commert.
L [CAMPFLSTR _MEMSElect_vas 1 Ofiler_wl,1% ndll
(CDAmpFLSTR_NGM 33 2 |SGM_Plus_v1.1% nul
E}“B.ﬂ.mpFLSTR_Panels_vl 3 |NGM_SElect_wz, 1% ndll
4 |Idenkifiler _Plus_v1.1% ndll
---[ESGM_F‘EIS_N JAX S |NGEM_w3 1X ndll
£ [OMGM_SElect_v2. 1% & |Idertifiler_Direct_w1.1% |null
g Ldgh:T:rl_ : lus vl 1% 7 |Profiler_Plus_v1.1X null
- 1dentifiler_Direct_v1.1% 5 |Profiler_v1.1% nul
[ﬁ Profiler_Phus_w1.1% a | SEfiler_Phus_w1.1% rdll
& DProfiler 1.1 10 |Tdenkifiler_vi. 1% nul
gfgg:ﬁ}ﬁzﬁ‘ﬂ;x 11 |MiniFiler_v1. 13 nul
---EMiniFiler_vl 1w 12 |Profiler_Plus_CODIS_wi. 1 {null
W T Prefiler Plie CODTS Wi 1Y 12 IwFiler w1 1% ruill
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8. Select and expand Identifiler_v1.1X in the navigation pane, then select D851179
to display the Bin view for the marker in the right pane.

« Panel Manager 3]
File Edit Bins View Help
B (5 MM JE U e sk amprLsTR_Bins_vax v foERE SEEEEEN e

=1 Identifiler _v1.1x ~
q ) 7 a a 10 11 12 12 14 15 16 17 12 19 20

03

0.3

o7

0.6

0.3

0.4

0.3

0.z

®
(0]
2
(0]
<
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©
e}
o}
)
S
>
w
o
=3
<
L
(0]

L MiniFiler_v1.13% 04
-ICProfiler_Plus_CODIS_v1.1% "
Ej---gvﬁl.:_vl.lx 120 120 140 150 160 170 180
-IC3COfler_CODIS_vl.1% L8
F-I T Idenkifiler CODIS wl.1 >

i 0251179

------ B Reference Samples <
M A78.57 v 0.40

[ OF H Cancel H Apply H Help ]

9. Import AmpFLSTR_Stutter_v2X:
a. Select the AmpFLSTR_Panels_v2X folder in the navigation panel.

« Panel Manager
File Edit Bins Yiew Help

X O EF M M ™ | inses |amprisTR Bns_ (v [ Il Ty I B B

=
= &Panel Manager Panel Hame Convment
[CAmpFLSTR_MGMSEleck w2y 1 Ofiler w1, 1% null =
(D AMpFLSTR_NGM_v3X 2 |SGM_Plus_wl.1% null
S-le 3 |NGM_SElect_wz.1% nul
4 |Identifiler_Plus_wi.1% null

b. Select File » Import Marker Stutter to open the Import Marker Stutter dialog
box.

c. Navigate to, then open the AmpFLSTR Analysis Files GMIDX folder.
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d.

Select AmpFLSTR_Stutter_v2X, then click Import.

Note: Importing this file associates the marker stutter ratio with the bin set
in the AmpFLSTR_v2X folder.

« Import Marker, Stutter ®
Look in: E AmpFLSTR. Analysis Filss GMIDH v | 5 ,:J|| =

L AmpFLSTR_Bins _ves
L AmpFLSTR_Panels_va
My Recent B AmpFLSTR_Stutte
Locuments | ] ReadMe_AmpFLSTR_w2X

&

]
iy
.

-
IS
h=]

My Documents

%! File name: |AmpFLSTR_Stutter_v2:.txt | [ mport |

My Compuker | Files of bype: |.0.II Files v| Cancel

10. View the imported marker stutters in the navigation pane:

a.

Double-click the AmpFLSTR_Panels_v2X folder to display its list of kits in
the right pane.

. Double-click the Identifiler_v1.1X folder to display its list of markers below

it.

Double-click D16S539 to display the Stutter Ratio & Distance view for the
marker in the right pane.

« Panel Manager

File Edit Bins ‘Wiew Help
Ex W HBE I BinSet: |AmpFLSTR_Bins_v2X v‘ A" L' BN B R R R R B
- 1dentifiler_v1.1% - '
. 0321'1';?;“’ || Flease enter the stutter filter(s) for D165539 marker here [f left blank, the global stutt
- D21511 be applied.
- D75820
s Minus Stutter Plus Stutter
" THO1 R.atio From Distance To Distance Ratio From Diskance 1
(- D135317 1 1040 3.25 4.75 1
- D165539
z 2
G- D251338 3 3
- D195433 4 4
i WA ¢ ] ¢
TR = [ mew 11 Edt 1] Delate |
11. Click Apply, then OK to add the Identifiler® Kit panel, bin set, and marker stutter
to the GeneMapper® ID-X Software database.
IMPORTANT! If you close the Panel Manager without clicking Apply, the panels,
bin sets, and marker stutter will not be imported into the GeneMapper® ID-X
Software database.
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Create an analysis  Use the following procedure to create an analysis method for the Identifiler® Kit.
method

IMPORTANT! Analysis methods are version-specific, so you must create an analysis
method for each version of the software. For example, an analysis method created for
GeneMapper® ID-X version 1.2 is not compatible with earlier versions of
GeneMapper® ID-X Software or with GeneMapper® ID Software version 3.2.1.

1. Select Tools » GeneMapper® ID-X Manager to open the
GeneMapper® ID-X Manager.

 GeneMapper® ID-X Manager (%]

Find Mame Conkaining:

(@)
(0]
=}
(0]
<
Q
e
e)
Q
)]
S
<
wn
o
=3
=
2
(0]

Projects | Analysis Methods | Table Settings || Plaot Settings || Matrices | Size Standards | Report Settings

[ Mew... ][ Open... ][ Save As... ][ Import... ][ Export,..

2. Select the Analysis Methods tab, then click New to open the Analysis Method
Editor with the General tab selected.

3. The figures below show the settings for each tab of the Analysis Method Editor.
Configure the Analysis Method Editor tab settings as shown in the figures below,
unless the instructions state otherwise.

Note: The Analysis Method Editor closes when you save your settings. To
complete this step quickly, do not save the analysis method until you finish
entering settings in all of the tabs.

4. After you enter settings in all tabs, click Save.
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General tab

settings Analysis Method Editor 3
General | Allele | Peak Detector | Peak Quality | 5Q & G Settings |
ranalysis Method Descripkion
Marie: |IdentiFiIer_P.naIysisMethnd_v2X |
Security Group: |GeneMapper ID-= Security Group w |
Description: =)
v
Instrument:
Analysis Type: HID
l Save l l Cancel l l Help l

In the Name field, either type the name as shown or enter a name of your choosing. In
the Security Group field, select the Security Group appropriate to your software
configuration from the dropdown list. The Description and Instrument fields are

optional.
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Allele tab settings

(%)

Analysis Method Editor

| General | Allele | Peak Detector | Peak Quality | 55 & G0 Settings |

Bin Set: nn-.pFLETF:__E:in:

Use marker-specific stutter ratio and distance if available
Marker Repeat Type: Tri Tetra Penta Hexa
Global Cut-off Value 0.0 0.0 0.0 0.0
Minus4 R.atio 0.0 0.0 0.0 0.0
Minusa Distance From (0.0 0.0 0.0 0.0
To (0.0 0.0 0.0 0.0
Global Minus Stutker Ratio 0.0 0.0 0.0 0.0
Global Minus Stutter Distance  From (0.0 3.25 0.0 0.0
To (0.0 4.75 0.0 0.0
Global Plus Skukter Ratio 0.0 0.0 0.0 0.0
Global Plus Stutter Distance From (0.0 0.0 0.0 0.0
To (0.0 0.0 0.0 0.0
Amelogenin Cukoff

Range Filter. .. Factory Defaulks

l Save ” Cancel ” Help l

¢ In the Bin Set field, select the AmpFLSTR_Bins_v2X bin set and configure the
stutter distance parameters as shown.

* GeneMapper® ID-X Software v1.0.1 or higher allows you to specify 4 types of
marker repeat motifs: tri, tetra, penta and hexa. You can enter parameter values
for each type of repeat in the appropriate column.

* Specify the stutter ratio:
— To apply the stutter ratios listed in the Allele tab for single-source data,
deselect the “Use marker-specific stutter ratio if available” check box

(selected by default). Perform appropriate internal validation studies to
determine the appropriate filter setting to use.

Note: Applying global stutter ratios may reduce the editing required for
single-source sample data.

— To apply the stutter ratios contained in the AmpFLSTR_Panels_v2.txt file,
select the “Use marker-specific stutter ratio if available” check box (selected
by default). Perform appropriate internal validation studies to determine the
appropriate filter setting to use.
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Peak Detector tab
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Analysis Method Editor &

eak Detector || peak Quality | 5O & GO Settings

General | Allele

Peak Detection Algorithrm: Advanced

Ranges Peak Detection
, iy Perform
Analysis Sizing Peak Amplitude Thresholds: internal
Ful Range all Sizes L . X .
B: R: validation
G: 0: studies to
determine
T settings
ramoothing and Baselining 9
Min. Peak Half ‘Width: 2 pts
Srnoakhing (") Mone
i ; ]
) Light Palynomial Degree
() Heawy Peak Window Size: 15 pts
Baseling Window: 51 pts Slape Threshold
Peak Start: 0.0
r3ize Calling Method Peak End: 0.0

(3 2nd Order Least Squares
() 3rd Order Least Squares
() Cubic Spline Interpolation
() Lacal Southern Method
() GGlobal Southern Method

Factory Defaulks

[ Save As ][ Save ][ Zancel ][ Help ]

IMPORTANT! Perform the appropriate internal validation studies to determine the
appropriate peak amplitude thresholds for interpretation of Identifiler® Kit data.

Fields include:

Peak amplitude thresholds — The software uses these parameters to specify the
minimum peak height, in order to limit the number of detected peaks. Although
GeneMapper® ID-X Software displays peaks that fall below the specified
amplitude in electropherograms, the software does not label or determine the
genotype of these peaks.

Size calling method — The Identifiler® Kit has been validated using the Local
Southern sizing method. Select alternative sizing methods only after you perform
the appropriate internal validation studies.

Normalization — A Normalization checkbox is available on this tab in
GeneMapper® ID-X Software v1.2 for use in conjunction with data run on the
Applied Biosystems 3500 Series Genetic Analyzers. Users of this version of
software should perform laboratory evaluations to determine whether to use the
Normalization feature for analysis of Identifiler® Kit data.
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Peak Quality tab
settings Analysis Method Editor 3]

ﬂnIMax Peak Height (LPHIMPH) \

Homozygous min peak. height I:I Perform

Heterozygous min peak height I:I internal o
validation @

I—— — i :
determine gz)

settings 3

Peak. Height Ratio (PHR) @
wn peak height: ratio I:l / i@
T

wn

Broad Peak (BDY %
Max peak width (basepairs) E
)

Allele Mumber (AR

Max expected alleles

I

Allelic Ladder Spike
Cut-off Yalue 0.z

[ Factory Defaults

[ Save H Cancel H Help ]

IMPORTANT! Perform the appropriate internal validation studies to determine the
minimum heterozygous and homozygous minimum peak height thresholds,
maximum peak height threshold and the minimum peak height ratio threshold for
interpretation of Identifiler® Kit data.

AmpFISTR® [dentifiler® PCR Amplification Kit User Guide 59



4 Chapter 4 GeneMapper® ID-X Software
Set up GeneMapper® ID-X Software for data analysis

SQ & GQ tab
settings

60

Analysis Method Editor ®

General | &llele | Peak Detector | Peak Quality |5Q 2 &0 Settings"ﬂ

Cuality weights are between 0 and 1,
rSample and Control GO Weighting

Broad Peak (BL) 0.5 Allele Mumber (AR 1.0
Dot of Bin Allele (BIN) 0.5 Low Peak Height (LPH) 0.3
Crverlap (OVL) 0.8 Max Peak Height: (MPH) 0.3
Marker Spike (SPK) 0.3 Off-scale (05) 0.8

Peak. Height Ratio (PHR) 0.3

Contral Concordance (ZC) Weight = 1.0 (Only applicable ko contrals)

30 weighting
Broad Peak (BD)

rallelic Ladder G0 weighting

Genobype Guality:

Spike (SSPKJSPE) Off-scale (03)
S0 & G0 Ranges
Sizing Ciuality: From | 0.75 to 1.0 FromO.0ko | 025

From | 0.75 to 1.0 From0.0ko | 0.25

Reset Defaulks

I
i
h=]

[ Save As ][ Save ][ Cancel ]

IMPORTANT! The values shown are the software defaults and are the values we used
during developmental validation. Perform appropriate internal validation studies to
determine the appropriate values to use.
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Analyze and edit sample files with GeneMapper® ID-X Software

1. In the Project window, select File » Add Samples to Project, then navigate to the
disk or directory containing the sample files.

2. Apply analysis settings to the samples in the project.

Parameter Settings

Sample Type Select the sample type.

Analysis Method | Identifiler_AnalysisMethod_v2X (or the name of the analysis
method you created)

Panel |dentifiler_v1.1X
Size Standard CE_G5_GS500(75-450)
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For more information about how the Size Caller works, or about size standards,
refer to the GeneMapper® ID-X Software v1.2 Reference Guide (Pub. no. 4426481A).

3. Click ™ (Analyze), enter a name for the project (in the Save Project dialog box),
then click OK to start analysis.
* The status bar displays the progress of analysis as a completion bar
extending to the right with the percentage indicated.
* The table displays the row of the sample currently being analyzed in green
(or red if analysis failed for the sample).

* The Analysis Summary tab is displayed and the Genotypes tab becomes
available upon completion of the analysis.
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Analysis summary window after analysis

# GeneMapper® ID-X - Identifiler Example - gmidx Is Logged In Database GBOLDROYNJO9E BE®
File Edit Analysis View Tools Admin  Help
[ ] E‘ % @ E' i E [ 3 @‘ Table Setting: | 31%% Data Analysis v| p & (& B e
B---%Project N Samples | Analysis Summary | Genotypes
- [ IdentiFiler Example] s |

Analysis Summary

Select run Folder to display:

Sample Status [ Total # of Samples ]
[@ Unanalyzed o
Analyzed 65
L)j Analysis Setting Changed o

Click a link below to display a filtered Samples Table containing only the samples selected.

Allelic Ladder Quality per run folder (based on SQ and CGQ only)

Run Folder [ Total # of Analyzed Ladders [
Identifiler Example 5

.

Control Quality per project (based on sample PQVs: SOS, SSPK, MIX, OMR, SQ, CGQ)

[ Control Type [ Takal # of Samples [ All threshaolds met [ 6 One or more thresholds not met
Positive Control 1] 1] 1]
Customn Contraol 1] 1] 1]
Megative Control o o o
Total 1] 1] 1]

Sample Quality per project (based on sample PQVs: SOS, SSPK, MIX, OMR, S0, CGQ)

[ [ Total # of Samples [ Al thresholds met [ 6 One or more thresholds not met ]
Samples 60 i) 52 |

Analysis Completed, Stop

Examine and edit a project

You can display electropherogram plots from the Samples and Genotypes tabs of the
Project window to examine the data. These procedures start with the Analysis
Summary tab of the Project window (assuming the analysis is complete).

For more information

For more information, refer to:
o GeneMapper® ID-X Software Version 1.0 Getting Started Guide (Pub. no. 4375574)
o GeneMapper® ID-X Software Version 1.0 Quick Reference Guide (Pub. no. 4375670)
o GeneMapper® ID-X Software Version 1.0 Reference Guide (Pub. no. 4375671)

o GeneMapper® ID-X Software Version 1.1(Mixture Analysis) Getting Started Guide
(Pub. no. 4396773)
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For more information

»  GeneMapper® ID-X Software Version 1.2 Reference Guide (Pub. no. 4426481)
o GeneMapper® ID-X Software Version 1.2 Quick Reference Guide (Pub. no. 4426482)

o GeneScan® Analysis Software for the Windows NT® Operating System Overview of the
Analysis Parameters and Size Caller User Bulletin (Pub. no. 4335617).
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Section 5.1 Developmental Validation

Overview

Importance of
validation

Experiment
conditions

66

This chapter provides results of the developmental validation experiments we
performed using the AmpF(STR® Identifiler® PCR Amplification Kit.

The data contained in this section was generated during the original developmental
validation of the Identifiler® Kit before its release in 2001. Since that time, we have
made a series of improvements to the Identifiler® Kit. For information on changes to
the Identifiler® Kit since 2001 and associated data, see:

* “Performance Verification After Primer Manufacturing Process Improvements”
on page 107

e “Performance Validation After Buffer and Enzyme Component Replacement” on
page 108

Validation of a DNA typing procedure for human identification applications is an
evaluation of the procedure’s efficiency, reliability, and performance characteristics. By
challenging the procedure with samples commonly encountered in forensic and
parentage laboratories, the validation process uncovers attributes and limitations
which are critical for sound data interpretation in casework (Sparkes, Kimpton,
Watson et al., 1996; Sparkes, Kimpton, Gilbard et al., 1996; Wallin ef al., 1998).

We performed experiments to evaluate the performance of the Identifiler® Kit
according to the DNA Advisory Board (DAB) Quality Assurance Standards, effective
October 1, 1998 (DNA Advisory Board, 1998). The DAB standards describe the quality
assurance requirements that a laboratory should follow to ensure the quality and
integrity of the data and competency of the laboratory.

These DAB standards describe the quality assurance requirements that a laboratory
should follow to ensure the quality and integrity of the data and competency of the
laboratory. DAB defines a laboratory as a facility in which forensic DNA testing is
performed.

Based on these standards, we conducted experiments which comply with Standards
8.1.1 and 8.1.2 and its associated subsections. Whereas this DNA methodology is not
novel, Standard 8.1.2 and its related subsections have been addressed (Holt ef al., 2001
and Wallin et al., 2001). This chapter will discuss many of the experiments we
performed and examples of the results we obtained. We used conditions that produced
maximum PCR product yield and a window in which reproducible performance
characteristics were met. These experiments, while not exhaustive, are appropriate for
a manufacturer, in our opinion. Each laboratory using the Identifiler® Kit should
perform appropriate validation studies.
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Developmental validation

Developmental validation

DAB 8.1.1
Developmental
Validation

PCR components

Thermal cycler
parameters

“Developmental validation that is conducted shall be appropriately documented.” (DNA
Advisory Board, 1998).

Critical reagent concentrations and reaction conditions (such as thermal cycling
parameters, AmpliTaq Gold® DNA polymerase activation, cycle number) to produce
reliable, locus-specific amplification and appropriate sensitivity have been
determined.

The concentration of each component of the Identifiler® Kit was examined. The PCR
components are Tris-HCl (pH 8.3), KCl, dNTPs, primers, AmpliTaq Gold® DNA
Polymerase, MgCl,, bovine serum albumin, and sodium azide. The concentration for a
particular component was established to be in the window that meets the reproducible
performance characteristics of specificity and sensitivity (Figure 5).

Figure5 A 1 ng amplification of genomic DNA varying the MgCl, concentration, analyzed on the
310 Genetic Analyzer
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Thermal cycling parameters were established for amplification of the Identifiler® Kit
in the GeneAmp® PCR Systems 9600 and 9700. Thermal cycling times and
temperatures of GeneAmp PCR systems were verified. Annealing and denaturation
temperature windows were tested around each stipend to verify that a +1.5°C window
produced a specific PCR product with the desired sensitivity of at least 1 ng of
AmpF(STR® Control DNA 9947A.

The effects of denaturation and annealing temperatures on the amplification of
Identifiler® Kit loci were examined using AmpF/(STR® Control DNA 9947A and two
DNA samples.
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AmpliTaq Gold®
DNA Polymerase
activation

68

The denaturation temperatures tested were 92.5, 94, and 95.5°C, all for 1-minute hold
times on the GeneAmp PCR System 9700. The annealing temperatures tested were 55,
57,59, 61, and 63°C (Figure 6), also for 1-minute hold times in the GeneAmp PCR
System 9700. The PCR products were analyzed using the 310 Genetic Analyzer.

Neither preferential nor differential amplification was observed in the denaturation
temperature experiments. Of the tested annealing temperatures, 55, 57, 59, and 61°C
produced robust profiles. At 63°C, the yield of the majority of loci was significantly
reduced. This should pose no problem with routine thermal cycler calibration and
when following the recommended amplification protocol. Preferential amplification
was not observed at any of the tested annealing temperatures.

Figure 6 An amplification of 1 ng of genomic DNA, amplified while varying the annealing
temperature, analyzed on the 310 Genetic Analyzer
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Identifiler® Kit reactions were amplified for 27, 28, 29, 30, and 31 cycles on the
GeneAmp® PCR System 9700 using 1.0 ng of three DNA samples. As expected, PCR
product increased with the number of cycles. A full profile was generated at 27 cycles;
off-scale data were collected for several allele peaks at 31 cycles.

While none of the cycle numbers tested produced nonspecific peaks, 28 cycles was
found to give optimal sensitivity when the amplified products were examined on 310
Genetic Analyzers. Additionally, the cycle number was set to avoid detection of low
quantities of DNA (20 pg or less). At 28 cycles, 1.0 ng of AmpF(STR® Control

DNA 9947A amplifies reliably and specifically following the conditions outlined in
this guide.
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Accuracy, precision, and reproducibility

Accuracy, precision, and reproducibility

DAB 8.1.2 Accuracy

Precision and size
windows

“Nowvel forensic DNA methodologies shall undergo developmental validation to ensure the
accuracy, precision and reproducibility of the procedure.” (DAB, 1998).

Laser-induced fluorescence detection systems of length polymorphism at short
tandem repeat loci is not a novel methodology (Holt et al., 2001 and Wallin et al., 2001).
However, accuracy and reproducibility of Identifiler® Kit profiles have been
determined from various sample types.

Figure 7 illustrates the size differences that are typically observed between sample
alleles and allelic ladder alleles on the 310 Genetic Analyzer with POP-4® polymer. The
x-axis in Figure 7 represents the nominal base pair sizes for the AmpF(STR®
Identifiler® Allelic Ladder, and the dashed lines parallel to the x-axis represent the
+0.5-bp windows. The y-axis is the deviation of each sample allele size from the
corresponding allelic ladder allele size. The data include a total of 2269 alleles from 70
population database samples. All sample alleles are within 0.5 bp of a corresponding
allele in an allelic ladder.

Figure 7 Size deviation of 70 samples and two allelic ladders from one injection of allelic ladder
on a single 310 Genetic Analyzer run
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Sizing precision allows for determining accurate and reliable genotypes. Sizing
precision was measured on the 310 Genetic Analyzer. The recommended method for
genotyping is to use a +0.5-bp “window” around the size obtained for each allele in the
AmpF(STR® Identifiler® Allelic Ladder. A +0.5-bp window allows for the detection
and correct assignment of alleles. An allele that sizes only one base pair different from
an allele in the allelic ladder will not be incorrectly typed and will be identified as off-
ladder. Any sample allele that sizes outside a window could be either of the following;:

* An “off-ladder” allele, for example, an allele of a size that is not represented in the
AmpF(STR® Identifiler® Allelic Ladder

* An allele that does correspond to an allelic ladder allele, but whose size is just
outside a window because of measurement error
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The measurement error inherent in any sizing method can be defined by the degree of
precision in sizing an allele multiple times. Precision is measured by calculating the
standard deviation in the size values obtained for an allele that is run in several
injections in one capillary run. Table 3 on page 70 indicates typical precision results
obtained from the seven injections of the AmpF(STR® Identifiler® Allelic Ladder
analyzed on the 310 Genetic Analyzer (47-cm capillary and POP-4® polymer). The
internal size standard used was GeneScan'" 500 LIZ® Size Standard. These results
were obtained within a set of injections on a single capillary.

As indicated above, sample alleles may occasionally size outside of the +0.5-bp
window for a respective allelic ladder allele because of measurement error. The
frequency of such an occurrence is lowest in detection systems having the smallest
standard deviations in sizing. Figure 7 on page 69 illustrates the tight clustering of
allele sizes obtained on the 310 Genetic Analyzer, where the standard deviation in
sizing is typically less than 0.15 bp. The instance of a sample allele sizing outside of the
+0.5-bp window because of measurement error is relatively rare when the standard
deviation in sizing is approximately 0.15 bp or less (Smith, 1995).

For sample alleles that do not size within a +0.5-bp window, the PCR product must be
rerun to distinguish between a true off-ladder allele vs. measurement error of a sample
allele that corresponds with an allele in the allelic ladder. Repeat analysis, when
necessary, provides an added level of confidence to the final allele assignment.
GeneMapper® ID Software and GeneMapper® ID-X Software automatically flags
sample alleles that do not size within the prescribed window around an allelic ladder
allele.

It is important to note that while the precision within a set of capillary injections is very
good, the determined allele sizes vary between platforms. Cross-platform sizing
differences arise from a number of parameters, including type and concentration of
polymer mixture, run temperature, and electrophoresis conditions. Variations in sizing
can also be found between runs on the same instrument and between runs on different
instruments because of these parameters. We strongly recommend that the allele sizes
obtained be compared to the sizes obtained for known alleles in the AmpF(STR®
Identifiler® Allelic Ladder from the same run and then converted to genotypes. For
more information on precision and genotyping, see Lazaruk et al., 1998 and Mansfield
et al.,1998.

1187 population database DNA samples have been typed using the Identifiler® Kit
(see”About the primers” on page 11). These samples have been previously genotyped
with concordant results of the same loci, using other AmpF(STR® kits.

Table 3 Example of precision results of seven injections of the AmpF(STR® Identifiler® Allelic
Ladder

310 Genetic Analyzer

Allele Mean Standard Deviation
Amelogenin

X 107.02 0.04

Y 112.61 0.02
CSF1PO

6 304.69 0.08

7 309.01 0.10
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310 Genetic Analyzer

Allele Mean Standard Deviation
8 313.30 0.10
9 317.55 0.11
10 321.97 0.12
1 325.86 0.11 O
12 329.97 0.13 §
13 334.00 0.10 %
14 338.04 0.11 5
15 341.84 0.08 5
D251338 g’
15 307.30 0.11 =
16 311.65 0.11
17 315.91 0.12
18 320.16 0.12
19 324.34 0.12
20 328.44 0.08
21 332.58 0.11
22 336.62 0.09
23 340.57 0.11
24 344.18 0.07
25 347.78 0.07
26 351.39 0.07
27 355.08 0.07
28 358.77 0.05
D351358
12 111.96 0.06
13 116.04 0.04
14 119.99 0.04
15 123.89 0.02
16 128.06 0.05
17 132.24 0.05
18 136.30 0.06
19 140.43 0.03
D55818
7 134.14 0.05
8 138.21 0.04
9 142.56 0.04
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310 Genetic Analyzer

Allele Mean Standard Deviation
10 147.02 0.06
1" 151.31 0.01
12 155.63 0.05
13 159.81 0.06
14 164.04 0.07
15 167.95 0.05
16 172.09 0.05
D7S820
6 255.15 0.08
7 259.21 0.07
8 263.24 0.07
9 267.26 0.09
10 271.32 0.08
" 275.35 0.06
12 279.42 0.07
13 283.42 0.06
14 287.48 0.10
15 291.58 0.06
D85S1179
8 123.29 0.07
9 127.32 0.05
10 131.41 0.05
1" 135.49 0.04
12 139.73 0.04
13 144.25 0.03
14 148.71 0.06
15 153.16 0.07
16 157.51 0.07
17 161.72 0.05
18 165.84 0.07
19 169.92 0.05
D135317
8 216.87 0.05
9 220.83 0.05
10 224.77 0.07
1" 228.88 0.07
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310 Genetic Analyzer

Allele Mean Standard Deviation
12 232.81 0.05
13 236.68 0.07
14 240.69 0.06
15 244.68 0.09 O
D165539 §
5 252.37 0.08 %
8 264.30 0.07 5
9 268.32 0.08 5
10 272.32 0.06 %
1 276.37 0.07 =
12 280.37 0.09
13 284.34 0.07
14 288.44 0.09
15 292.51 0.07
D18S51
7 262.07 0.08
9 270.22 0.06
10 274.34 0.09
10.2 276.36 0.06
1 278.41 0.08
12 282.49 0.05
13 286.57 0.06
13.2 288.63 0.05
14 290.77 0.04
14.2 292.78 0.05
15 294.91 0.07
16 299.07 0.06
17 303.50 0.07
18 307.94 0.09
19 312.40 0.11
20 316.71 0.09
21 320.99 0.14
22 325.24 0.11
23 329.40 0.11
24 333.54 0.15
25 337.67 0.11
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310 Genetic Analyzer

Allele Mean Standard Deviation
26 341.56 0.09
27 345.24 0.08

D19S433
9 101.99 0.05
10 105.88 0.05
" 109.78 0.04
12 113.64 0.02
12.2 115.61 0.02
13 117.56 0.03
13.2 119.55 0.02
14 121.46 0.03
14.2 123.47 0.02
15 125.45 0.05
15.2 127.43 0.05
16 129.44 0.05
16.2 131.46 0.05
17 133.42 0.03
17.2 135.44 0.06

D21S11
24 184.86 0.04

24.2 186.82 0.02
25 188.77 0.03
26 192.69 0.05
27 196.56 0.04
28 200.41 0.05

28.2 202.36 0.05
29 204.32 0.03

29.2 206.31 0.02
30 208.29 0.07

30.2 210.24 0.05
31 212.23 0.05

31.2 21414 0.06
32 21614 0.04

32.2 218.10 0.04
33 220.14 0.05

33.2 222.07 0.04
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310 Genetic Analyzer

Allele Mean Standard Deviation
34 224.10 0.07
34.2 226.02 0.06
35 228.07 0.06
35.2 230.01 0.07 O
36 232.04 0.07 §
37 236.00 0.03 %
38 239.94 0.08 5
FGA 5
17 214.81 0.07 §
18 218.80 0.06 =
19 222.79 0.07
20 226.81 0.06
21 230.76 0.08
22 234.78 0.07
23 238.81 0.05
24 242.83 0.07
25 246.88 0.06
26 250.96 0.06
262 253.00 0.09
27 254.97 0.08
28 259.02 0.10
29 263.12 0.08
30 267.26 0.09
30.2 269.07 0.10
31.2 273.17 0.09
322 277.24 0.08
33.2 281.33 0.09
42.2 319.83 0.14
432 324.04 0.14
44.2 328.26 0.13
45.2 332.42 0.16
46.2 336.43 0.14
472 340.42 0.14
48.2 344.15 0.10
50.2 351.45 0.05
51.2 355.13 0.05
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310 Genetic Analyzer

Allele Mean Standard Deviation
THO1
4 163.29 0.04
5 167.36 0.03
6 171.40 0.05
7 175.40 0.03
8 179.38 0.04
9 183.36 0.05
9.3 186.93 0.02
10 187.29 0.04
" 191.23 0.03
13.3 201.94 0.05
TPOX
6 222.07 0.04
7 226.02 0.06
8 229.91 0.03
9 233.86 0.06
10 237.88 0.07
" 241.83 0.06
12 245.77 0.07
13 249.78 0.08
VWA
" 154.59 0.08
12 158.87 0.07
13 163.00 0.05
14 167.27 0.05
15 171.15 0.05
16 175.15 0.04
17 179.15 0.04
18 183.08 0.04
19 187.00 0.04
20 190.93 0.05
21 194.80 0.05
22 198.62 0.06
23 202.44 0.05
24 206.69 0.08
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Extra Peaks in the electropherogram

Causes of extra To further demonstrate reproducibility, 1187 population database DNA samples have
peaks been typed using the Identifiler® Kit. These samples have been previously genotyped
with concordant results of the same loci using other AmpF(STR® kits.

Peaks other than the target alleles may be detected on the electropherogram displays.
Several causes for the appearance of extra peaks, including the stutter product (at the
n—4 position), incomplete 3" A nucleotide addition (at the n—1 position), artifacts, and
mixed DNA samples (see “DAB 8.1.2.2 Mixture Studies” on page 91).

Stutter products The PCR amplification of tetranucleotide STR loci typically produces a minor product
peak four bases shorter (n—4) than the corresponding main allele peak. This is referred
to as the stutter peak or product. Sequence analysis of stutter products at
tetranucleotide STR loci has revealed that the stutter product is missing a single
tetranucleotide core repeat unit relative to the main allele (Walsh et al.,1996).
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The proportion of the stutter product relative to the main allele (percent stutter) is
measured by dividing the height of the stutter peak by the height of the main allele
peak. Such measurements have been made for amplified samples at the loci used in the
Identifiler® Kit. All data were generated on the 310 Genetic Analyzer.

Some of the general conclusions from these measurements and observations are as
follows:

e Tor each Identifiler® Kit locus, the percent stutter generally increases with allele
length, as shown in Figure 8 through Figure 12 on the following pages. Smaller
alleles display a lower level of stutter relative to the longer alleles within each
locus. This is reflected in Figure 8 through Figure 11, where minimal data points
are plotted for some smaller alleles, as stutter could not be detected for many of
these samples.

¢ For the alleles within a particular locus, the percent stutter is generally greater for
the longer allele in a heterozygous sample (this is related to the first point above).

* Each allele within a locus displays percent stutter that is reproducible.

¢ The highest percent stutter observed for each allele is as follows: CSF1PO, 9.2%;
D251338, 11.1%; D351358, 10.7%; D55818, 6.8%; D75820, 8.2%; D851179, 8.2%;
D135317, 8.0%; D165539, 10.4%; D18S51, 17.0%; D195433, 13.3%; D21511, 9.4%;
FGA, 14.7%; THO1, 5.1%; TPOX, 4.8% and vWA, 12.6%.

¢ The highest observed percent stutter for each locus is included as the filter in the
GeneMapper® ID Software and the GeneMapper® ID-X Software. Peaks in the
stutter position that are above the highest observed percent stutter will not be
filtered. Peaks in the stutter position that have not been filtered and remain
labeled can be further evaluated. For evaluation of mixed samples, see “Mixture
studies” on page 91.
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* The percent stutter does not change significantly with the recommended quantity
of input DNA, for on-scale data. The measurement of percent stutter may be
unusually high for main peaks that are off-scale.

* The percent stutter for allele 15 in D3S1358 (Figure 9) is artificially increased due
to a reproducible artifact (Figure 4-8) observed in the green dye lanes at this
position. When analyzing samples which contain a D351358 allele 15, we
recommend careful examination due to the contribution that this identified
artifact may add to the observed peak height or area. The highest percent stutter
for D351358 is not inconclusive of allele 15.

Figure 8 Stutter percentages for the D851179, D21511, D75820, and CSF1PO loci
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Figure 9 Stutter percentages for the D351358, TH01, D13S317, D165539, and D251338 loci. See
the comment on page 78 regarding stutter at allele 15 of D351358
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Figure 10 Stutter percentages for the D195433, vWA, TPOX, and D18551 loci
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Figure 11 Stutter percentages for the D55818 and FGA loci
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Figure 12 Sample 1 in panel A and panel B has a profile of 15, 16 for D351358. The amount of
stutter can not be accurately measured due to the VIC® dye artifact. Note the degree of
magpnification (y-axis) used in panels B and C to illustrate the artifact. Data was produced on
the 310 Genetic Analyzer.
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Section 5.1 Developmental Validation

Extra Peaks in the electropherogram

AmpliTaq Gold® enzyme, like many other DNA polymerases, can catalyze the
addition of a single nucleotide (predominately adenosine) to the 3" ends of
double-stranded PCR products (Clark, 1988; Magnuson et al.,1996). This non-template
addition results in a PCR product that is one base pair longer than the actual target
sequence, and the PCR product with the extra nucleotide is referred to as the “+A”
form (Figure 13).

The efficiency of “A addition” is related to the particular sequence of the DNA at the 3’
end of the PCR product. The Identifiler® Kit includes two main design features that
promote maximum A addition:

* The primer sequences have been optimized to encourage A addition.

¢ The final extension step is 60°C for 60 minutes.

This final extension step gives the AmpliTaq Gold® DNA Polymerase extra time to
complete A addition to all double-stranded PCR product. STR systems that have not
been optimized for maximum A addition may have “split peaks”, where each allele is
represented by two peaks one base pair apart.

Figure 13 Split peaks resulting from incomplete A nucleotide addition due to omission of the
60-minute extension step

|+ BV 17 160 Tes To0 158

N Extension

500 Final Extension

The AmpliTaq Gold® DNA Polymerase generally requires extra time to complete the A
nucleotide addition at the 3" end of the PCR products.

Lack of full A nucleotide addition may be observed in Identifiler® Kit results when the
amount of input DNA is greater than recommended protocols. This is because more
time is needed for AmpliTaq Gold® DNA Polymerase to add the A nucleotide to all
molecules as more PCR product is generated. Amplification of too much input DNA
will also result in off-scale data.

Artifacts, or anomalies, have been seen in data produced on the 310 Genetic Analyzer

when using the Identifiler® Kit. The shape of these artifacts is not consistent with the

shape of labeled DNA fragments as seen on the 310 Genetic Analyzer. Artifacts may or
not be reproducible.
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Characterization of loci

Artifacts can be intermittent and are not always reproducible. In our experience,
non-reproducible artifacts can be correlated to sources other than the kit (that is,
spikes). An intermittent artifact is not observed in the same position upon re-injection.

Figure 14 demonstrates reproducible artifacts while using the Identifiler® Kit.
Consider these artifacts when interpreting data.

Figure 14 Reproducible anomalies in the blue, green, yellow, and red dye electropherograms

when using the Identifiler® Kit. Genotyping may result in the detection of these artifacts as
off-ladder alleles, or “OL Alleles”. Note the degree of magnification (y-axis) used in this figure
to illustrate these artifacts. Data produced on the 310 Genetic Analyzer.
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Characterization of loci

DAB 8.1.2.1
Documentation

Overview

Nature of the
polymorphisms

82

“Documentation exists and is available which defines and characterizes the locus.” (DAB,
1998).

This section describes basic characteristics of the 16 loci that are amplified with the
Identifiler® Kit. These loci have been previously characterized.

The primers for the Amelogenin locus flank a six-base pair deletion within intron 1 of
the X homologue. Amplification results in 107-bp and 113-bp products from the X and
Y chromosomes, respectively. (Sizes are the actual base pair size according to
sequencing results, including 3' A nucleotide addition.) The remaining Identifiler® Kit
loci are all tetranucleotide short tandem repeat (STR) loci. The length differences
among alleles of a particular locus result from differences in the number of 4-bp repeat
units.
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Species specificity

We have subjected to DNA sequencing some alleles in the AmpF(STR® Identifiler®
Allelic Ladder containing partial repeat units in population database and nonhuman
primate DNA samples (Lazaruk, et al., 2001). In addition, other groups in the forensic
community have sequenced alleles at some of these loci (Nakahori et al., 1991; Puers et
al., 1993; Moller et al., 1994; Barber et al., 1995; Moller and Brinkmann, 1995; Barber et
al., 1996; Barber and Parkin, 1996; Brinkmann et al., 1998; Momhinweg et al., 1998;
Watson et al., 1998). Among the various sources of sequence data on the Identifiler®
Kit loci, there is consensus on the repeat patterns and structure of the STRs.

Inheritance The AmpF(STR® loci have been validated by family studies to demonstrate their
mode(s) of inheritance.

The Centre d’Etude du Polymorphisme Humain (CEPH) has collected DNA from

39 families of Utah Mormon, French Venezuelan, and Amish descent. These DNA sets
have been extensively studied all over the world and are routinely used to characterize
the mode of inheritance of various DNA loci. Each family set contains three
generations, generally including four grandparents, two parents, and several
offspring. Consequently, the CEPH family DNA sets are ideal for studying inheritance
patterns (Begovich et al.,1992).

Four CEPH family DNA sets were examined. One and a half nanograms of DNA from
each sample were amplified using the AmpF(STR® SGM Plus® kit, followed by
analysis using an 377 DNA Sequencer. The families examined included #1331

(11 offspring), #13291 (9 offspring), #13292 (9 offspring), and #13294 (8 offspring),
representing 37 meiotic divisions. The results confirmed that the loci are inherited
according to Mendelian rules, as has been reported in the literature (Nakahori et
al.,1991; Edwards et al.,1992; Kimpton et al.,1992; Mills et al.,1992; Sharma and Litt,
1992; Li et al.,1993; Straub et al.,1993).

Ma pping The Identifiler® Kit loci Amelogenin, CSF1PO, D251338, D351358, D55818, D75820,
D8S1179, D135317, D16S539, D18S51, D195433, D21S11, EGA, THO1, TPOX and vWA
have been mapped and the chromosomal locations have been published (Nakahori
et al., 1991; Edwards et al.,1992; Kimpton et al.,1992; Mills et al.,1992; Sharma and
Litt,1992; Li et al.,1993; Straub et al.,1993; Barber and Parkin,1996).

Species specificity

DAB 8.1.2.2 “Species specificity, sensitivity, stability and mixture studies are conducted.” (DAB, 1998).

Species Specificity  pe 1dentifiler® Kit provides the required degree of specificity such that it is specific to
primates. Other species do not amplify for the loci tested, with the exception of the

Amelogenin locus.

Nonhuman Studies

Nonhuman DNA may be present in forensic casework samples. The Identifiler® Kit
provides the required degree of specificity such that it is specific to primates for the
species tested (with the exception of the Amelogenin locus) (Figure 15).
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Species specificity

Figure 15 Representative electropherograms of a primate, non-primates, a microorganism, and
a negative control are shown. All samples were analyzed on an 310 Genetic Analyzer. The peaks
shown in orange are the GeneScan™ 500 LIZ® Size Standard.
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The following experiments were conducted to investigate interpretation of
Identifiler® Kit results from nonhuman DNA sources.

The extracted DNA samples were amplified in Identifiler® Kit reactions and analyzed
using the 310 Genetic Analyzer.
* Primates — Gorilla, chimpanzee, orangutan, and macaque (1.0 ng each).
* Non-primates — Mouse, dog, pig, cat, horse, chicken and cow (2.5 ng each).
* Bacteria and yeast — Brochothrix, Escherichia, Neisseria, Pseudomonas, Bacillus,
Staphylococcus (approximately 5 ng each), and Saccharomyces (1 ng).

The primate DNA samples all amplified, producing fragments within the 100400 base
pair region (Lazaruk, et al., 2001; Wallin ef al.,1998).

The microorganisms, chicken, cow, cat and mouse did not yield detectable product.
Horse, dog, and pig produced a 103-bp fragment near the Amelogenin locus in PET®
dye.
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DAB 8.1.2.2
Sensitivity

Effect of DNA
quantity on results
and importance of
quantitation

Section 5.1 Developmental Validation

Sensitivity

“Species specificity, sensitivity, stability and mixture studies are conducted.” (DAB, 1998).

The amount of input DNA added to the Identifiler® Kit should be between 0.5 and
1.25 ng (Figure 16 on page 86). The DNA sample should be quantitated prior to
amplification using a system such as the Quantifiler® Human DNA Quantitation Kit
(Part no. 4343895). The final DNA concentration should be in the range of

0.05-0.125 ng/uL so that 0.5-1.25 ng of DNA will be added to the PCR reaction in a
volume of 10 pL. If the sample contains degraded DNA, amplification of additional
DNA may be beneficial.

If too much DNA is added to the PCR reaction, then the increased amount of PCR
product that is generated can result in the following:

¢ Fluorescence intensity that exceeds the linear dynamic range for detection by the
instrument (“off-scale” data).

Off-scale data is a problem for two reasons:

— Quantitation (peak height and area) for off-scale peaks is not accurate. For
example, an allele peak that is off-scale can cause the corresponding stutter
peak to appear higher in relative intensity, thus increasing the calculated
percent stutter.

— Multicomponent analysis of off-scale data is not accurate, which results in
poor spectral separation (“pull-up”).

¢ Incomplete A nucleotide addition.
The sample can be re-amplified using less DNA.

When the total number of allele copies added to the PCR is extremely low, unbalanced
amplification of the two alleles of a heterozygous individual may occur (Walsh

et al.,1992; Wallin et al.,1998) due to stochastic fluctuation in the ratio of the two
different alleles (Sensabaugh et al.,1991). The PCR cycle number and amplification
conditions have been specified to produce low peak heights for a sample containing
20 pg human genomic DNA. Low peak heights should be interpreted with caution.

Individual laboratories may find it useful to determine an appropriate minimum peak
height threshold based on their own results and instruments using low amounts of
input DNA.
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Stability

Figure 16 Effect of amplifying various amounts of DNA ranging from 16 pg to 1 ng. Note that the y-axis scale is magnified
for the lower amounts of DNA. Data analyzed using the 310 Genetic Analyzer

EE I1 20 I1 g0 J a0 I21 a I24U IE?U ISUU ISSD
2800 | Tng
1950 _|
1300 |
850 |

1 A | 1il W V1T Y
2600 | O.Sng
1950 ]

1300
EE50 | l l k

ol k b ik i Aaa Aa Add i P PO W
E2mD] 0.25ng
1950 1
1300
850 ]

ol & ia ks Y aad i h .. adk . PO VO G
800 0.125ng
500 |
400 |
200 |

ol & “._ l i boa s ‘ k oy A ‘ l i A l. l i
800 0.0625ng
500 |
400
200 |

ol & kb ‘ a A ' i - - - ad o A A_Q_A_.l._u‘_‘_%
] 0.031ng
300 ]

200 ]
100 ]

ol d ha A a " " ' i . A_._ A
] 0.016ng
300 ]

200 ]
100 ]

[/ A& PR s A a b
400 ] Megative Control
300 ]

200 ]
100 ]
o L,

Stability

DAB 8.1.2.2
Stability

Lack of

amplification of

some loci

86

“Species specificity, sensitivity, stability and mixture studies are conducted.” (DAB, 1998).

As with any multi-locus system, the possibility exists that not every locus will amplify.
This is most often observed when the DNA sample contains PCR inhibitors or when
the DNA sample has been severely degraded. Because each locus is an independent
marker whose results are not based upon information provided by the other markers,
results generally can still be obtained from the loci that do amplify.

AmpFtSTR® Identifiler® PCR Amplification Kit User Guide



Section 5.1 Developmental Validation
Stability

Differential and Differential amplification can be defined as the difference in the degree of
preferential amplification of each locus within a co-amplified system, such that one or more loci
may amplify to a greater extent compared to the other loci. Preferential amplification is
used in this guide to describe differences in the amplification efficiency of two alleles
at a single locus.

amplification

Preferential amplification of alleles in systems that distinguish alleles based on length
polymorphisms is most likely to be observed when the alleles differ significantly in
base pair size. Since most Identifiler® Kit loci have small size ranges, the potential for
preferential amplification of alleles is low.

Effect of inhibitors Heme compounds have been identified as PCR inhibitors in DNA samples extracted
from bloodstains (DeFranchis et al.,1988; Akane et al., 1994). It is believed that the
inhibitor is co-extracted and co-purified with the DNA and subsequently interferes
with PCR by inhibiting polymerase activity.
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Bovine serum albumin (BSA) can prevent or minimize the inhibition of PCR, most
likely by binding to the inhibitor (Comey et al., 1994). Since the presence of BSA can
improve the amplification of DNA from blood-containing samples, BSA has been
included in the AmpF(STR® PCR Reaction Mix at 4 pg per 25-uL amplification. BSA
has also been identified as an aid in overcoming inhibition from samples containing
dyes, such as in denim (Comey et al., 1994).

To examine the effects of hematin on the amplification results obtained by the
Identifiler® Kit, DNA samples were amplified using the Identifiler® Kit reagents
(including the BSA-containing PCR reaction mix) in the presence of varying
concentrations of purified hematin. The concentrations of hematin used were 0 uM,
10 uM, 12 uM,, 14 uM,, 16 uM, 18 uM, and 20 uM. When the amount of hematin was
increased to a concentration that started to inhibit the PCR, CSF1PO and D251338 were
the first loci to exhibit decreased amplification, followed by D165539 and D185S51.

Differential amplification was observed in the presence of increasing amounts of
hematin. Moreover, as the concentration of hematin was increased, the overall yield of
products was reduced particularly for the larger loci.
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Figure 17 DNA amplified with the Identifiler® Kit in the presence of varying concentrations of hematin: 0, 10 uM, 12 uM,
14 uM, 16 uM, 18 uM, and 20 uM, analyzed on the 310 Genetic Analyzer
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Degraded DNA

88

As the average size of degraded DNA approaches the size of the target sequence, the
amount of PCR product generated is reduced. This is due to the reduced number of
intact templates in the size range necessary for amplification.

Degraded DNA was prepared to examine the potential for differential amplification of
loci. High molecular weight DNA was incubated with the enzyme DNase I for varying
amounts of time. The DNA was examined by agarose gel analysis to determine the
average size of the DNA fragments at each time point.

Four nanograms of degraded DNA (or 1 ng undegraded DNA) was amplified using
the Identifiler® Kit (all 16 primer pairs together). As the DNA became increasingly
degraded the loci became undetectable according to size. Preferential amplification
was not observed. The loci failed to robustly amplify in the order of decreasing size as
the extent of degradation progressed: CSF1PO and D251338 were the first loci to
exhibit decreased amplification, followed by D165539 and D18551 and so forth. A
similar result at each time point was obtained whether the DNA samples were
amplified for each locus alone or co-amplified with the Identifiler® Kit (Figure 18 on
page 89).
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Figure 18 Multiplex amplifications of a DNA sample in the absence of DNase | and the sample incubated for 30 sec, 1 min,
4 min, and 8 min with DNase |, analyzed using the 310 Genetic Analyzer
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Multiplex
amplifications

DNA samples were amplified in 16 separate reactions containing primers for only one
Identifiler® Kit locus (singleplex) and a reaction containing all primers for the
Identifiler® Kit loci (multiplex). DNA used as PCR template consisted of a sample that
had been degraded for 1 min with DNase L.

Amplified samples were analyzed using the 310 Genetic Analyzer. Similar results were
obtained (genotype and peak height) whether the DNA samples were amplified for
each locus alone or co-amplified in the Identifiler® Kit reaction(Figure 19 on page 90).

When degraded DNA is suspected to have compromised amplification of one or more
loci, the molecular weight of the DNA can be assessed by agarose gel analysis. If the
DNA is degraded to an average of 400 base pairs in size or less, adding more DNA
template to the Identifiler® Kit amplification reaction may help produce a typeable
signal for the loci. Adding more DNA to the amplification may provide more of the
necessary size template for amplification.
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Figure 19 Multiplex and singleplex amplifications of a DNA sample incubated for 1 min with

DNase |, analyzed on the 310 Genetic Analyzer
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Mixture studies

DAB 8.1.2.2 “Species specificity, sensitivity, stability and mixture studies are conducted.” (DAB, 1998).

Mixture Studies Evidence samples may contain DNA from more than one individual. The possibility of

multiple contributors should be considered when interpreting the results. We
recommend that individual laboratories assign a minimum peak height threshold
based on validation experiments performed in each laboratory to avoid typing when

stochastic effects are likely to interfere with accurate interpretation of mixtures.
Mixed specimen Evidence samples that contain body fluids and/or tissues originating from more than
studies one individual are an integral component of forensic casework. Therefore it is essential

to ensure that the DNA typing system is able to detect DNA mixtures. In the case of
STRs, stutter peaks may be informative in the interpretation of mixed samples.
Furthermore, alleles amplified with the Identifiler® Kit have similar peak height
values for a heterozygous genotype within a locus. This balance can be used as an aid
in detecting and interpreting mixtures.
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Detection of mixed samples

Each of the following can aid in determining whether a sample is a mixture:
* The presence of more than two alleles at a locus.

* The presence of a peak at a stutter position that is significantly greater in
percentage than what is typically observed in a single-source sample.

¢ Significantly imbalanced alleles for a heterozygous genotype.
The peak height ratio is defined as the height of the lower peak (in RFU) divided
by the height of the higher peak (in RFU), expressed as a percentage. Mean,
median, and minimum and maximum peak height ratios observed for alleles in
the Identifiler® Kit loci in unmixed population database samples are listed in

Table 4.
Table 4 Peak height ratios
Allele Number of Mean? Mediant | Minimum? Maximumt
Observations (n)
CSF1PO 84 86 88 63.6 99.8
D251338 93 84 86 42.8 99.7
D351358 91 88 90 64.3 99.7
D55818 82 89 91 64.9 99.7
D75820 96 89 90 66.2 99.5
D8S1179 89 90 93 57.5 99.8
D13S317 96 87 87 63.3 100.0
D165539 92 88 91 61.5 99.9
D18S51 99 82 83 56.3 99.9
D195433 98 88 92 48.8 100.0
D21S11 92 88 89 66.4 99.6
FGA 94 85 87 60.9 99.5
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Allele Ob:leur:‘abt?:nzf[n] Mean? Mediant | Minimumt Maximumt
THO1 99 86 88 48.8 99.9
TPOX 87 87 92 55.9 99.8
VWA 101 86 88 62.8 99.1

T Peak height ratios were determined for those heterozygous samples with peak heights > 200 RFU.

For all 15 loci, the mean peak height ratios indicate that the two alleles of a
heterozygous individual are generally very well balanced.

If an unusually low peak height ratio is observed for one locus and there are no other
indications that the sample is a mixture, the sample may be reamplified and
reanalyzed to determine if the imbalance is reproducible. Possible causes of imbalance
at a locus are degraded DNA, presence of inhibitors, extremely low amounts of input
DNA, or the presence of an allele containing a rare sequence that does not amplify as
efficiently as the other allele.

Resolution of genotypes in mixed samples
A sample containing DNA from two sources can be comprised (at a single locus) of
any of the seven genotype combinations listed below.
* Heterozygote + heterozygote, no overlapping alleles (four peaks)
* Heterozygote + heterozygote, one overlapping allele (three peaks)
¢ Heterozygote + heterozygote, two overlapping alleles (two peaks)
* Heterozygote + homozygote, no overlapping alleles (three peaks)
* Heterozygote + homozygote, overlapping allele (two peaks)
¢ Homozygote + homozygote, no overlapping alleles (two peaks)
* Homozygote + homozygote, overlapping allele (one peak)
Specific genotype combinations and input DNA ratios of the samples contained in a

mixture determine whether it is possible to resolve the genotypes of the major and
minor component(s) at a single locus.

The ability to obtain and compare quantitative values for the different allele peak
heights on Applied Biosystems instruments provides additional valuable data to aid in
resolving mixed genotypes. This quantitative value is much less subjective than
comparing relative intensities of bands on a stained gel.

Ultimately, the likelihood that any sample is a mixture must be determined by the
analyst in the context of each particular case, including the information provided from
known reference sample(s).

Limit of detection of the minor component

Mixtures of two DNA samples were examined at various ratios (1:1 to 1:10). The total
amount of genomic input DNA mixed at each ratio was 1 ng.

The samples were amplified in a GeneAmp® PCR System 9700 with a silver or
gold-plated silver block and were electrophoresed and detected using a 310 Genetic
Analyzer.
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Mixture studies

The results of the mixed DNA samples are shown in Figure 20, where sample A and
sample B were mixed according to the ratios provided.

The profiles of the samples in Figure 20 are listed in Table 5.

Table 5 Mixture profiles

Profile
Allele Sample A Sample B

Amelogenin X XY
CSF1PO 10, 12 11,12
D251338 17, 25 20, 23
D351358 15, 18 15,16
D55818 11,13 1
D75820 9,10 7,12
D851179 13 12,13
D13S317 1" 1"
D165539 11,12 9,10
D18551 17,19 12, 15
D19S433 13 14,15
D21S11 30, 30.2 28, 31
FGA 23.2, 24 24, 26
THO1 7,9 7,93
TPOX 8,9 8
VWA 17,19 14,16

For these 1-ng total DNA mixture studies, the limit of detection is when the minor
component is present at approximately one-tenth of the concentration of the major
component and a threshold of 50 RFU. The limit of detection for the minor component
is influenced by the combination of genotypes in the mixture.
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Data interpretation

Figure 20 Results of the two DNA samples mixed together at defined ratios and amplified with the Identifiler® Kit. Sample
A and Sample B are a female and male sample, respectively. The ratios of Sample A to Sample B (A:B ratios) shown are
10:1, 3:1, 1:1, 1:3, and 1:10, respectively. The alleles attributable to the minor component, even when the major component
shares an allele, are highlighted in panels 2, 3, 5, and 6. All alleles are highlighted in panel 4.
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Data interpretation

Minimum sample
requirement

The Identifiler® Kit has been optimized to reliably amplify and type approximately
0.5-1.25 ng of sample DNA.

The PCR cycle number and amplification conditions have been specified to produce
low peak heights for a sample containing 20 pg human genomic DNA. Thus, the
overall sensitivity of the assay has been adjusted to avoid or minimize stochastic
effects. We have successfully typed samples containing less than 0.5 ng DNA.

Note: Individual laboratories may find it useful to determine an appropriate
minimum peak height threshold based on their own results/instruments using low
amounts of input DNA.

Population data

DAB 8.1.2.3
Population Data

DAB 8.1.2.3.1
Population
Distribution Data

94

“Population distribution data are documented and available.” (DAB, 1998).

“The population distribution data would include the allele and genotype distributions for the
locus or loci obtained from relevant populations. Where appropriate, databases should be tested
for independence expectations.” (DAB, 1998).
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Population data

To interpret the significance of a match between genetically typed samples, it is
necessary to know the population distribution of alleles at each locus in question. If the
genotype of the relevant evidence sample is different from the genotype of the
suspect’s reference sample, then the suspect is “excluded” as the donor of the
biological evidence tested. An exclusion is independent of the frequency of the two
genotypes in the population.

If the suspect and evidence samples have the same genotype, then the suspect is
“included” as a possible source of the evidence sample. The probability that another,
unrelated, individual would also match the evidence sample is estimated by the
frequency of that genotype in the relevant population(s).

The Identifiler® Kit, prior to the addition of the D851179 degenerate primer, was used
to generate the population data provided in this section. Samples were collected from
individuals throughout the United States with no geographical preference.

Number
Population of Samples provided by
samples
African-American 357 Kentucky State Police and the Federal Bureau of
U.S. Caucasian 349 Investigation
U.S. Hispanic 290 Minnesota Bureau of Criminal Apprehension/Memorial
. . Blood Center of Minneapolis
Native American 191

Table 6 shows the Identifiler® Kit allele frequencies in four populations, listed as
percentages.

Table 6 Identifiler® Kit allele frequencies

Allele African-American U.S. Caucasian U.S. Hispanic Native American
(n=357) (n = 349) (n=290) (n=191)

CSF1PO

6 t t t t

7 4.62 0.14% 0.34% T

8 7.56 0.29% 0.17t 0.527

9 3.78 1.72 0.86% 8.38
10 27.87 ' 2421 23.10 30.89
1" 20.59 31.81 28.28 21.99
1.3 0.14% T T T

12 29.13 32.81 39.66 32.72
13 5.32 ' 7.31 6.38 4.7
14 0.98 1.43 0.867 0.791
15 T 0.29% 0.34% T
D2S1338

15 0.147 T T T

16 5.32 4.73 2.41 2.62
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Population data

Allele African-American U.S. Caucasian U.S. Hispanic Native American
(n=357) (n = 349) (n =290) (n=191)

17 10.78 17.34 21.21 9.95
18 5.60 6.30 414 7.07
19 14.15 13.75 22.76 29.58
20 6.02 14.61 13.79 9.69
21 14.01 2.58 2.59 2.36
22 13.17 4.01 7.41 15.18
23 10.78 11.46 11.38 11.78
24 9.80 11.75 8.45 7.85
25 8.12 10.60 517 3.14
26 1.96 2.72 0.697 0.79t
27 0.147 0.147 T T

28 T T T T

96 AmpFISTR® Identifiler® PCR Amplification Kit User Guide



Section 5.1 Developmental Validation

Population data

Allele African-American U.S. Caucasian U.S. Hispanic Native American
(n=357) (n = 349) (n =290) (n =191)

D351358
<11 0.42% 0.14% T T
" T t T 0.267
12 0.56% T 0.17t T
13 0.70% 0.291 0.17% t
14 12.04 15.76 7.41 6.81
15 30.53 25.36 39.14 40.84
15.2 0.14% T T T
16 28.57 22.78 26.72 32.98
17 19.47 18.19 16.03 9.95
18 6.72 16.48 8.97 8.38
19 0.84 1.00 1.03 0.79%
20 T T 0.347 t
D55818
7 0.14% t 6.72 15.71
8 5.46 T 0.69% T
9 1.68 4.15 5.17 6.02
10 6.72 5.44 517 4.19
1" 25.49 39.26 39.14 41.10
12 36.41 35.24 29.31 23.30
13 21.57 15.47 12.59 9.42
14 2.38 0.147 0.697 0.267
15 T 0.29% 0.18t t
16 T T 0.17t T
17 0.14% T 0.17t T
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Population data

Allele African-American U.S. Caucasian U.S. Hispanic Native American
(n=357) (n = 349) (n =290) (n=191)
D7S820
6 T 0.147 0.17% f
7 0.42% 1.29 1.72 0.527
8 18.77 16.48 11.72 13.09
9 13.73 17.62 6.21 8.12
10 34.45 27.22 27.41 21.99
" 19.89 18.05 28.79 28.80
12 10.78 14.76 20.17 24.08
13 1.54 3.72 3.45 3.40
14 0.427 0.72 0.347 f
15 T T T T
D851179
8 0.42F 2.29 0.347 0.521
9 0.427 1.15 0.347 0.267
10 2.38 9.74 8.45 4.71
" 3.92 6.02 5.86 3.40
12 13.31 14.04 12.07 11.52
13 23.25 32.52 32.93 37.43
14 30.11 21.35 26.21 30.63
15 20.17 9.89 10.86 9.42
16 4.62 2.72 2.41 1.57
17 1.12 0.297 0.527 0.527
18 0.28% t T t
19 T T T T
D13S317
8 3.08 12.18 9.66 4.97
9 2.52 7.74 21.72 17.80
10 3.78 444 9.14 13.61
" 24.51 29.80 23.10 24.35
12 46.22 30.80 20.86 23.04
13 15.41 11.17 10.17 7.85
14 4.34 3.72 534 8.12
15 0.14% 0.14% T 0.267
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Population data

Allele African-American U.S. Caucasian U.S. Hispanic Native American
(n=357) (n = 349) (n=290) (n =191)

D16S539
5 t t t t
8 3.22 1.72 1.72 0.79%
9 19.05 10.46 9.31 12.30
10 10.92 5.59 15.69 15.45
1" 31.51 31.95 30.17 30.89
12 18.77 30.23 29.48 27.75
13 14.85 16.76 11.55 10.73
14 1.54 3.01 2.07 2.09
15 0.147 0.297 T T
D18S51
7 t t + t
9 0.14% T T t
10 0.28% 0.86 0.527 0.791
10.2 0.14% t T t
1" 0.28* 1.15 1.21 T
12 7.00 13.90 10.34 14.92
13 4.34 12.18 14.48 9.16
13.2 0.42% t T t
14 6.86 16.76 15.52 26.96
14.2 0.28% T T T
15 19.47 13.61 16.55 12.04
16 16.53 13.61 11.72 10.73
17 18.21 12.32 14.14 14.66
18 11.90 7.74 6.72 2.62
19 6.02 444 414 3.93
20 4.90 1.72 2.24 1.83
21 2.10 1.00 1.03 1.31
22 0.70% 0.43% 0.52F 0.79%
23 0.427 0.147 0.527 0.26%
24 T 0.14% 0.17t t
25 T T 0.17t T
26 T T T T
27 t t t t
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Population data

Allele African-American U.S. Caucasian U.S. Hispanic Native American
(n=357) (n = 349) (n =290) (n=191)

D19S433

9 T 0.147 0.17% f

10 1.54 T T T

" 7.14 0.72 0.52F 0.527
1.2 0.14% T 0.17% t

12 10.78 ' 7.74 6.21 3.14
12.2 6.30 0.577 1.90 T

13 29.83 28.94 16.03 17.80
13.2 5.74 1.72 8.62 15.45
14 21.01 ' 34.10 31.72 24.87
14.2 4.20 0.86 5.00 3.66
15 4.76 15.76 13.45 13.35
15.2 3.36 2.72 8.79 10.73
16 2.38 ' 4.15 4.31 3.93
16.2 2.38 1.72 2.93 1.83
17 T 0.29% 0.17t 0.79%
17.2 0.28% 0.29% T 2.88
18.2 0.14 ' 0.29 t 1.05%
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Section 5.1 Developmental Validation

Population data

Allele African-American U.S. Caucasian U.S. Hispanic Native American
(n=357) (n = 349) (n=290) (n =191)

D21S11

214 t t t t
24.2 0.14% 0.43% 0.17t t
24.3 0.28* T T T
25 T T T T
25.2 T 0.147 0.17% f
26 0.14% 0.14% 0.17t t
27 5.04 4.58 1.21 0.52t
28 22.97 16.76 9.14 6.28
28.2 t t t t
29 19.33 20.49 21.21 16.75
29.2 0.14% T 0.52F 0.267
29.3 0.14% T T t
30 17.23 25.21 29.31 34.29
30.2 1.40 3.30 2.93 1.83
31 7.98 7.16 6.72 5.76
31.2 7.98 9.46 8.62 18.85
32 1.12 1.43 1.55 0.797
32.2 5.88 7.16 12.93 9.69
33 0.56% T T 0.527
33.2 3.78 3.30 414 3.66
34 1.26 T T T
34.1 0.14% t T t
34.2 0.14% 0.29% 0.86% 0.79%
35 2.94 T 0.34% T
35.1 0.147 T T T
35.2 T 0.14% T t
36 0.84 T U T
37 0.28% T T T
38 0.147 T T T
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5 Chapter 5 Experiments and Results
Population data

Allele African-American U.S. Caucasian U.S. Hispanic Native American
(n = 357) (n = 349) (n = 290) (n=191)

FGA
16 t 0.14t t t
16.1 0.14% t t t
17 t 0.29t 0.17 t
17.2 0.14t t t t
18 0.70* ' 2.72 0.52° 131
18.2 1.40 t t t
19 6.72 6.16 7.07 10.21
19.2 0.28t t t T
20 7.00 ' 13.90 7.41 12.30
20.2 t 0.14t t t
21 12.89 16.91 14.66 12.83
21.2 t 0.291 0.17t t
22 21.57 ' 16.91 17.24 10.47
22.2 0.28t 1.29 0.34t 0.26*
22.3 0.14% t t T
23 14.99 15.19 11.90 15.97
23.2 0.14* ' t 0.86" 0.26"
24 17.51 13.75 15.34 15.71
24.2 t 0.14t 0.17 t
25 7.98 8.60 14.14 14.14
26 3.50 ' 2.72 6.90 4.45
26.2 t t t 0.52
27 1.82 0.72 2.41 0.79*
28 1.40 0.14% 0.691 0.52
29 0.56" ' t t t
30 t t
30.2 0.14% t t T
31.2 T T T T
32.2 t t t +
33.2 t T t +
34.2 0.14% t t T
42.2 T T T T
43.2 t ' t t t
44.2 0.28" ' t t T
45.2 t t t 0.26*
46.2 0.14* t t t
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Section 5.1 Developmental Validation

Population data

Allele African-American U.S. Caucasian U.S. Hispanic Native American
(n=357) (n = 349) (n=290) (n =191)

FGA (continued)
47.2 t t t t
48.2 0.14% t T t
50.2 T T T T
51.2 t t : t §
THO1 ‘g’
4 t t t t o}
5 0.28* 0.43% 0.17t T fz:
6 11.06 20.49 22.76 20.68 %
7 42.86 21.78 33.62 43.98 S]
8 20.73 11.46 8.45 5.24
8.3 T 0.14% U T
9 12.32 16.19 14.14 6.28
9.3 11.62 ' 29.08 20.34 23.56
10 0.98 0.43% 0.52t 0.267
11 T T T T
13.3 0.14% T T T
TPOX
6 6.72 0.14% 0.34% t
7 2.24 T 0.34% 0.267
8 36.13 53.30 49.66 37.96
9 21.15 ' 11.60 7.24 419
10 9.24 4.30 4.66 3.40
1" 21.43 25.93 27.24 39.27
12 3.08 4.73 10.52 14.92
13 t t t t
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Chapter 5 Experiments and Results

Population data

Allele African-American U.S. Caucasian U.S. Hispanic Native American
(n = 357) (n = 349) (n = 290) (n =191)

VWA

11 0.28" t 0.17% t

12 t t | t | 0.26"
13 1.26 0.43" t 0.26%
14 7.14 8.31 | 6.90 | 4.45
15 20.03 11.32 10.00 7.07
16 26.75 23.35 | 34.31 | 32.98
17 20.59 24.50 21.55 33.51
18 14.71 22.49 | 18.45 | 15.45
19 6.72 8.31 7.07 4.71
20 1.96 1.15 | 138 | 1,05t
21 0.28" t 0.17* 0.26%
22 0.28" t | t | t

23 1t 1 1 T

24 t 0.14" | t | t

t A minimum allele frequency (0.7% for the African-American database, 0.7% for the U.S. Caucasian database, 0.9% for the U.S. Hispanic database,
and 1.3% for the Native American database) is suggested by the National Research Council in forensic calculations.

Analyzing the four
databases

Low-frequency
alleles

104

Analysis across the four databases of 2274 total chromosomes per locus revealed the
following number of different alleles: 10 CSF1PO alleles, 13 D251338 alleles, at least
12 D351358 alleles, 11 D5S818 alleles, 9 D75820 alleles, 11 D851179 alleles, 8 D135317
alleles, 8 D165539 alleles, 20 D185S51 alleles, 17 D195433 alleles, 26 D21S11 alleles,

31 FGA alleles, 9 THO1 alleles, 7 TPOX alleles, and 13 vWA alleles.

In addition to the alleles that were observed and recorded in the our databases, other
known alleles have been published or reported to us by other laboratories (see
STRBase, www.cstl.nist.gov/div831/strbase).

Some alleles of the Identifiler® Kit loci occur at a low frequency. For these alleles, a
minimum frequency (5/ 21, where n = the number of individuals in the database) was
assigned for the Identifiler® Kit African-American, U.S. Caucasian, U.S. Hispanic, and
Native American databases, as suggested in the 1996 report of the Committee on DNA
Forensic Science (National Research Council, 1996). These databases are summarized
in Table 6 on page 95 through page 104. The minimum reportable genotype frequency
at each locus is as follows: 1.19 x 104 for the African-American database; 1.19 x 104 for
the U.S. Caucasian database; 1.70 x 104 for the U.S. Hispanic database; and 2.97 x 104
for the Native American database [p2 + p(1-p) 6, where 6 = 0.01]. Hence, the minimum
combined multilocus genotype frequency at 15 loci is as follows: 1.36 x 1075 for the
African-American database; 1.36 x 10759 for the U.S. Caucasian database; 2.86 x 1057
for the U.S. Hispanic database; and 1.23 x 1023 for the Native American database.
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Mutation rate

Estimating
germline
mutations

Additional
mutation studies

Section 5.1 Developmental Validation

Mutation rate

Estimation of spontaneous or induced germline mutation at genetic loci may be
achieved through comparison of the genotypes of offspring to those of their parents.
From such comparisons the number of observed mutations are counted directly.

In previous studies, genotypes of ten STR loci amplified by the AmpF(STR® SGM®
Plus PCR Amplification Kit were determined for a total of 146 parent-offspring allelic
transfers (meioses) at the Forensic Science Service, Birmingham, England. One
length-based STR mutation was observed at the D18511 locus; mutation was not
detected at any of the other nine STR loci. The D18511 mutation was represented by an
increase of one 4-bp repeat unit, a 17 allele was inherited as an 18 (single-step
mutation). The maternal/paternal source of this mutation could not be distinguished.

Additional studies (Edwards et al.,1991; Edwards et al.,1992; Weber and Wong, 1993;
Hammond et al.,1994; Brinkmann et al.,1995; Chakraborty ef al.,1996; Chakraborty

et al.,1997; Brinkmann et al.,1998; Momhinweg et al.,1998; Szibor et al.,1998) of direct
mutation rate counts produced:

* Larger sample sizes for some of the Identifiler® Kit loci.

® Methods for modifications of these mutation rates (to infer mutation rates
indirectly for those loci where these rates are not large enough to be measured
directly and/or to account for those events undetectable as Mendelian errors).

Probability of identity

Table 7 shows the Probability of Identity (Py) values of the Identifiler® Kit loci
individually and combined.

Table 7 Probability of Identity values for the Identifiler® Kit STR loci

Locus African-American U.S. Caucasian U.S. Hispanic Native American
CSF1PO 0.079 0.132 0.141 0.123
D251338 0.023 0.027 0.038 0.043
D351358 0.097 0.076 0.112 0.158
D55818 0.104 0.147 0.115 0.110
D75820 0.085 0.063 0.083 0.081
D8S1179 0.074 0.064 0.089 0.104
D13S317 0.132 0.079 0.056 0.056
D165539 0.077 0.097 0.090 0.082
D18S51 0.033 0.031 0.031 0.046
D19S433 0.042 0.087 0.049 0.044
D21S11 0.037 0.044 0.047 0.074
FGA 0.034 0.035 0.032 0.031
THO1 0.109 0.079 0.097 0.134
TPOX 0.089 0.188 0.168 0.159
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Chapter 5 Experiments and Results

Probability of paternity exclusion

Locus African-American U.S. Caucasian U.S. Hispanic Native American
VWA 0.066 0.066 0.080 0.103
Combined 1.31 x 10718 5.01 x 1018 7.65 x 1018 3.62 x 10717

The P; value is the probability that two individuals selected at random will have an
identical Identifiler® Kit genotype (Sensabaugh, 1982). The P values for the
populations described in this section are then approximately 1/7.64 x 1017
(African-American), 1/2.00 x 1017 (U.S. Caucasian), 1/1.31 x 1017 (U.S. Hispanic),
and 1/2.76 x 1016 (Native American).

Probability of paternity exclusion

Table 8 shows the Probability of Paternity Exclusion (Pg) values of the Identifiler® Kit
STR loci individually and combined.

Table 8 Probability of Paternity Exclusion for the Identifiler® Kit STR loci

Locus African-American U.S. Caucasian U.S. Hispanic Native American
CSF1PO 0.545 0.496 0.450 0.409
D251338 0.748 0.725 0.671 0.399
D351358 ” 0.591 0.630 | 0.495 0.510
D55818 0.506 0.440 0.525 0.601
D75820 ' 0.591 0.582 | 0.574 0.492
D8S1179 0.580 0.680 0.599 0.601
D135317 ” 0.383 0.487 | 0.438 0.370
D165539 0.649 0.566 0.567 0.428
D18551 ' 0.760 0.731 | 0.767 0.329
D195433 0.601 0.531 0.678 0.360
D21511 ” 0.737 0.708 | 0.586 0.399
FGA 0.760 0.766 0.739 0.309
THO1 ' 0.492 0.566 | 0.618 0.646
TPOX 0.521 0.329 0.392 0.487
VWA ” 0.709 0.625 | 0.555 0.528
Combined 0.9999996 0.9999992 0.9999990 0.9999527
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Chapter 5 Performance Verification After Primer Manufacturing Process Improvements

Section 5.2 Performance Verification After Primer
Manufacturing Process Improvements

As part of our continual efforts to improve the quality of our products, several
improvements and updates have been made to the manufacturing process of the
Identifiler® Kit (Part no.4322288) since its introduction in 2001.

Effective from kit lot number 0310018, modifications were made to the manufacturing
process of the Identifiler® Kit to reduce the occurrence of artifacts in the PET® dye and
VIC® dye channels that may interfere with the interpretation of casework samples.

We amplified negative control samples using lot number 0301011 and lot number
0310018 and generated data using the 310 Genetic Analyzer with the Windows® NT
OS using the G5 module. Results show that the VIC® and PET® labeled artifacts are
greatly reduced in the after the manufacturing process improvements (Figure 21).

Figure 21 Comparison of the observed VIC® dye- and PET® dye-labeled artifacts for negative control amplifications with
Identifiler® Kit lot numbers before and after kit lot number 0310018. The artifacts have been highlighted for illustrative

purposes.
VIC® dye labelled artifact at ~120 bp PET® dye labeled artifacts between
Amelogenin and D55818 loci
B 110 120 130 110 120 120
180 Lot no. 0301011 180 ] Lot no. 0301011
160 (representative of lots 160 (representative of lots
140 0103001~ 0308017) 140 0103001~ 0308017)
Before 120 ]
process 100 1
improvements 5 1
o
‘ 1 A A
\ 2 !
\ﬂ'a\._l. RS A 0 Jreo gl TRy ] I«)/r»\ i
180 ] Lot no. 0310018 180 ] Lot no. 0310018
1] (representative of lots 160 ] (representative of lots
After bz 0310018 and later) 140 0310018 and later)
process 120 ] 120
improvements 100 | 100 ]
50 &0
60 60 |
40 40 ]
] 20 ]
- (TR,

For more information, refer to AmpF(STR® Identifiler® PCR Amplification Kit Human
Identification Application Note (Pub. no. 040302).
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Chapter 5 Performance Validation After Buffer and Enzyme Component Replacement

Overview

Section 5.3 Performance Validation After Buffer and
Enzyme Component Replacement

Overview

Experiments

108

As part of an ongoing program to exercise greater control over raw materials used in
the AmpF(STR® PCR Amplification Kits, manufacturing of the AmpliTaq Gold®
enzyme and 10X PCR Buffer II (Tris-KCl buffer) components is transitioning from
Roche Molecular Systems to Life Technologies. Manufacturing of both components by
Life Technologies will be conducted according to the same specifications used
previously by Roche. The in-house components are established raw materials in our
next generation kits (for example, the NGM™, NGM SElect™" and Identifiler® Plus
Kits).

We performed studies to compare the performance of the Identifiler® Kit containing
the in-house components (updated kit) with the performance of the original kit,
focusing on studies most relevant to forensic DNA testing (see SWGDAM Guidelines
effective January 1, 2011). These studies, while not exhaustive, are in our opinion
appropriate for a manufacturer.

Our studies compared the performance of two Roche-manufactured enzyme and
buffer lots (Control mixes) with three new lots of buffer and two new lots of enzyme
manufactured by Life Technologies (Test mixes). Studies were performed using Test
mixes containing both the enzyme and buffer manufactured by Life Technologies.

Test_ Control Amix | Control B mix @ Test A mix Test B mix Test C mix
Material
Buffer Control Buffer | Control Buffer | Test Buffer Test Buffer Test Buffer
Lot 1 Lot 2 Lot 1 Lot 2 Lot 3
Enzyme Control Control TestEnzyme | Control TestEnzyme
Enzyme Enzyme Lot 1 Enzyme Lot 2
Lot 1 Lot 2 Lot 2

Each of the five mixes listed above were used to conduct reproducibility, sensitivity,
and inhibition studies. All amplifications were performed using a GeneAmp® PCR
System 9700 with either silver or gold-plated silver block using the recommended

amplification conditions and cycle number for the Identifiler® Kit. All data was run on
an Applied Biosystems 3130x! Genetic Analyzer running Data Collection Software v3.0
and analyzed using GeneMapper® ID-X Software. Subsequent data analysis was
performed using Minitab® Statistical Software. To minimize the effect of injection-to-
injection variation on result interpretation, peaks heights for all studies were
normalized using an in-house, multicolor reference standard.
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Section 5.3 Performance Validation After Buffer and Enzyme Component Replacement
Reproducibility study

Reproducibility study

For the reproducibility study, 12 replicates of control DNA 007 at 1 ng input and three
negative control replicates were amplified. The results were evaluated for intracolor
balance, stutter percentage, and the presence, signal intensity, and location of artifacts.

Intracolor balance No significant difference (<10% increase or decrease) in the level of intracolor balance
was observed between the Test and Control mixes (Figure 22).

Figure 22 Reproducibility study: intracolor balance
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Chapter 5 Performance Validation After Buffer and Enzyme Component Replacement

Reproducibility study
Stutter Stutter percentage results for each marker were comparable across all Test and Control
percentages mixes (Flgure 23)
Figure 23 Reproducibility study: mean stutter percentage
104 Rezgent Lot
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Dye Color and Locus
Artifacts Known artifacts observed showed the same morphology, signal intensity, and location

in all Test and Control mixes and did not exceed 50 RFU (Figure 24). No new artifacts
were observed in the Test mixes.

Figure 24 Reproducibility study: known artifacts (Y-scale 100 RFU)

VIC® dye labeled artifact at ~70 bp NED® dye labeled artifact at ~88 bp
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Section 5.3 Performance Validation After Buffer and Enzyme Component Replacement

Sensitivity study

Mean referenced

peak height

Sensitivity study

For the sensitivity study, dilution series of three genomic DNA samples were
amplified: 1 ng (three replicates each), 0.5 ng, 0.25 ng, and 0.125 ng (four replicates
each). The results were evaluated for mean referenced peak height, degree of linearity
between input DNA concentration and peak height, level of allelic dropout at 125 pg,
and genotype concordance.

Mean referenced peak height observations were consistent between all Test and
Control mixes (Figure 25) demonstrating equivalent performance (Figure 26).

Figure 25 Sensitivity study: mean referenced peak heights three genomic DNA samples
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Chapter 5 Performance Validation After Buffer and Enzyme Component Replacement
Sensitivity study

Figure 26 Sensitivity study: representative electropherograms for Sample 2 amplified using
125 pg input DNA (Y-scale 500 RFU)
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DNA concentration The calculated slope and R2 values for each of the plotted curves were equivalent,

and peak height showing comparable relationships between peak height and DNA input amount for
the Test and Control mixes (Figure 27). In general, the Test mixes showed a slight
increase in peak height compared to the Control mixes.

Figure 27 Sensitivity study: linear regression plot of combined mean referenced peak height for
three genomic DNA samples
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Section 5.3 Performance Validation After Buffer and Enzyme Component Replacement
Sensitivity study

Allelic dropout Allelic dropout was observed only for amplifications of 125 pg where dropout of a
single allele was observed for Test A Sample 1 (Figure 28) and Control B Sample 3
(Figure 29). These results can be explained by stochastic variation and sampling from
dilute DNA solutions. Allelic dropout results can therefore be considered equivalent
between Test and Control mixes.

Figure 28 Sensitivity study: electropherogram of 125 pg Sample 1 amplified with Test A mix. One

allele at the FGA locus in the PET® (Red) dye channel is below the analysis threshold of 50 RFU.
(Y-scale 300 RFU)
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Figure 29 Sensitivity study: electropherogram of 125 pg Sample 3 amplified with Control B mix.

One allele at the FGA locus in the PET® (Red) dye channel is below the analysis threshold of
50 RFU. (Y-scale 300 RFU)
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Chapter 5 Performance Validation After Buffer and Enzyme Component Replacement
Inhibition study

Genotype Genotypes for Test and Control mixes were 100% concordant (Table 9).
concordance Table 9 Sensitivity study: genotype concordance
DNA Input Amount Reagent Mix Genotype Concordance
125 pg Test A 100%
Test B 100%
Test C 100%
Control A 100%
Control B 100%
250 pg Test A 100%
Test B 100%
Test C 100%
Control A 100%
Control B 100%
500 pg | Test A 100%
Test B 100%
Test C 100%
Control A 100%
Control B 100%
1ng Test A 100%
Test B 100%
Test C 100%
Control A 100%
Control B 100%

Inhibition study

An inhibition series of 1 ng control DNA 007 (consisting of uninhibited control, Humic
Acid at a final concentration of 15.25 ng/uL, and Hematin at a final concentration of
34 uM in replicates of five) was amplified using each of Test and Control mixes. The
amount of each inhibitor tested was titrated to cause an approximate 50% reduction in
overall peak height of the samples. Results were evaluated for mean referenced peak
height, minimum referenced peak height, intracolor balance, and levels of allelic

dropout.
Mean referenced Uninhibited Control DNA 007 Test and Control mixes displayed no significant
peak height, difference in mean referenced peak height, minimum referenced peak height, and

mini intracolor balance. For the Humic Acid-inhibited and Hematin-inhibited DNA,
Inimum . . .

f d peak however, the Test mixes showed slightly improved performance compared to the

re _erence P Control mixes for mean referenced peak height, intracolor balance, and minimum
!1e|ght, and referenced peak height (Figure 30, 31, and 32). All results obtained for all Test and
intracolor balance Control mixes fall within the expected range of performance for the Identifiler® Kit.
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Section 5.3 Performance Validation After Buffer and Enzyme Component Replacement

Inhibition study

Figure 30 Inhibition study: mean referenced peak height. Inhibitors: HA = Humic Acid,

HE = Hematin, PRI = Pristine or Uninhibited DNA
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Figure 31 Inhibition study: minimum referenced peak height. Inhibitors: HA = Humic Acid,

HE = Hematin, PRI = Pristine or Uninhibited DNA
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Chapter 5 Performance Validation After Buffer and Enzyme Component Replacement
Inhibition study

Figure 32 Inhibition study: intracolor balance. (Y-axis intracolor balance percentage versus
X-axis dye color. Inhibitors: HA = Humic Acid, HE = Hematin, PRI = Pristine or Uninhibited DNA
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Representative electropherograms from the inhibition study are shown in Figure 33,
34, and 35.

Figure 33 Inhibition study: representative electropherograms using uninhibited Control DNA
007 (Y-scale 4000 RFU)
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Section 5.3 Performance Validation After Buffer and Enzyme Component Replacement
Inhibition study

Figure 34 Inhibition study: representative electropherograms using Control DNA 007 inhibited
with 34 pM Hematin (Y-scale 4000 RFU])
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Figure 35 Inhibition study: representative electropherograms using Control DNA 007 inhibited
with15.25 ng/pL Humic Acid (Y-scale 4000 RFU)
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Allelic dropout No allelic dropout events were seen for any Test or Control mixes tested on
uninhibited Control DNA 007 and Control DNA 007 inhibited with Hematin or Humic
Acid.
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Chapter 5 Performance Validation After Buffer and Enzyme Component Replacement

Conclusions

Conclusions

118

Laboratories can expect to obtain equivalent quality profiles across a wide range of
forensic samples when using the Identifiler® Kit containing the AmpliTaq Gold®
enzyme and 10X PCR Buffer Il manufactured by Life Technologies as compared to the
original Identifiler® Kit containing AmpliTaq Gold® enzyme and 10X PCR Buffer II
manufactured by Roche Molecular Systems.
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Troubleshooting

Follow the actions recommended in this appendix to troubleshoot problems that occur

during analysis.

Table 10 Troubleshooting

Observation

Possible causes

Recommended actions

Faint or no signal from
both the AmpF(STR®
Control DNA 9947A and
the DNA test samples at
all loci

Incorrect volume or absence of PCR
Master Mix or Identifiler® Primer Set

Repeat amplification.

No activation of AmpliTaq Gold® DNA
Polymerase

Repeat amplification, making sure to hold
reactions initially at 95°C for 11 minutes.

Master Mix not vortexed thoroughly
before aliquoting

Vortex the Master Mix thoroughly.

Identifiler® Primer Set exposed to too
much light

Store the Primer Set protected from light.

GeneAmp® PCR System malfunction

Refer to the thermal cycler user’s manual and
check instrument calibration.

Use of incorrect thermal cycling
parameters

Check the protocol for correct thermal cycling
parameters.

Tubes not seated tightly in the
thermal cycler during amplification

Push reaction tubes firmly into contact with block
after first cycle. Repeat test.

Wrong PCR reaction tube

Use Applied Biosystems MicroAmp® Reaction
Tubes with Caps for the GeneAmp® PCR System
9700.

MicroAmp® Base used with tray/
retainer set and tubes in GeneAmp®
9700

Remove MicroAmp® Base from tray/retainer set
and repeat test.

Insufficient PCR product
electrokinetically injected

Prepare PCR product as described in Chapter 3,
“Perform Electrophoresis” on page 25.

Degraded formamide

Check the storage of formamide; do not thaw and
refreeze multiple times. Try Hi-Di"" Formamide.
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Appendix A Troubleshooting

Observation

Possible causes

Recommended actions

Positive signal from
AmpF(STR® Control
DNA 9947A but partial or
no signal from DNA test
samples

Quantity of test DNA sample is below
assay sensitivity

Quantitate DNA and add 1.0 ng of DNA. Repeat
test.

Test sample contains high
concentration of PCR inhibitor (for
example, heme compounds, certain
dyes)

Quantitate DNA and add minimum necessary
volume. Repeat test.

Wash the sample in a Centricon®-100 centrifugal
filter unit. Repeat test.

Test sample DNA is severely
degraded

If possible, evaluate the quality of DNA sample by
running an agarose gel. If DNA is degraded,
reamplify with an increased amount of DNA or use
the AmpF(STR® MiniFiler™ Kit.

Dilution of test sample DNA in water
or wrong buffer (for example, TE
formula with incorrect EDTA
concentration)

Redilute DNA using low-TE Buffer (with 0.1 mM
EDTA.

More than two allele
present at a locus

Presence of exogenous DNA

Use appropriate techniques to avoid introducing
foreign DNA during laboratory handling.

Amplification of stutter product

See “Stutter products” on page 77.

Mixed sample

Some but not all loci
visible on
electropherogram of
DNA test samples

Test-sample DNA is severely
degraded

If possible, evaluate the quality of DNA sample by
running an agarose gel. If DNA is degraded,
reamplify with an increased amount of DNA or use
the AmpF(STR® MiniFiler™ Kit.

Test sample contains high
concentrations of a PCR inhibitor (for
example, heme compounds, certain
dyes)

Quantitate DNA and add minimum necessary
volume. Repeat test.

Wash the sample in a Centricon®-100 centrifugal
filter unit. Repeat test.

Poor peak height

Incorrect thermal cycler parameters

Check the protocol for correct thermal cycler

balance parameters.
GeneAmp® PCR System 9700 with Use Applied Biosystems GeneAmp® PCR System
Aluminum 96-Well block or third- 9700 with silver or gold-plated silver blocks only,
party thermal cyclers or the Veriti® 96-Well Thermal Cycler.
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Ordering Information

Equipment and materials not included

Table 11 and Table 12 list required and optional equipment and materials not supplied
with the Identifiler® Kit. Unless otherwise noted, many of the items are available from
major laboratory suppliers (MLS).

Table 11 Equipment

Equipment Source

3100/3100-Avant Genetic Analyzer Contact your local

Applied Biosystems 3130/3130x{ Genetic Analyzer Life Technologies_
sales representative

Applied Biosystems 3500/3500xL Genetic Analyzer for Human Identification

Applied Biosystems 310 Genetic Analyzer

GeneAmp® PCR System 9700 with the Silver 96-Well Block ' N8050001
GeneAmp® PCR System 9700 with the gold-plated silver 96-well block 4314878
Veriti® 96-Well Thermal Cycler 4375786
Silver 96-well sample block N8050251
Gold-plated silver 96-well sample block ' 4314443
Tabletop centrifuge with 96-well plate adapters (optional MLS

Table 12 User-supplied materials

Item? Source
AmpF(STR® Identifiler® PCR Amplification Kit 4322288
3100 Analyzer materials
96-well plate septa 4315933
Reservoir septa 4315932
3100/3130x! Genetic Analyzer capillary array, 36-cm 4315931
POP-4® polymer for 3100/3100-Avant Genetic Analyzers 4316355
3100/3100-Avant Genetic Analyzer Autosampler Plate Kit, 96-well ' 4316471
GeneScan™ 500 LIZ® Size Standard 4322682
OR OR
GeneScan™ 600 LIZ® Size Standard v2.0 4408399
Running Buffer, 10X ' 402824
Hi-Di™ Formamide 4311320
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E Appendix B Ordering Information

Equipment and materials not included

Itemt? Source
DS-33 Matrix Standard Kit (Dye Set G5) 4345833
MicroAmp® Optical 96-well reaction plate N8010560
250-pL glass syringe (array-fill syringe) 4304470
5.0-mL glass syringe (polymer-reserve syringe) 628-3731

For a complete list of parts and accessories for the 3100/3100-Avant instrument, refer to Appendix B of the 3700 Genetic
Analyzer and 3100-Avant Genetic Analyzer User Reference Guide (Pub. no. 4335393).

3130x! Analyzer materials

96-well plate septa 4315933
Reservoir septa 4315932
3100/3130x( Genetic Analyzer capillary array, 36-cm 4315931
POP-4® polymer for 3130/3130x( Genetic Analyzers 4352755
3100/3100-Avant Genetic Analyzer Autosampler Plate Kit, 96-well 4316471
GeneScan™ 500 LIZ® Size Standard 4322682
OR OR
GeneScan™ 600 LIZ® Size Standard v2.0 4408399
Running Buffer, 10X 402824
DS-33 Matrix Standard Kit (Dye Set G5) 4345833
MicroAmp® Optical 96-well reaction plate N8010560
Hi-Di™ Formamide 4311320

For a complete list of parts and accessories for the 3130/3130x( instrument, refer to Appendix A of the Applied Biosystems
3130/3130x( Genetic Analyzers Maintenance, Troubleshooting, and Reference Guide (Pub. no. 4352716).

3500/3500xL Analyzer materials

Anode buffer container (ABC) 4393927
Cathode buffer container (CBC) 4408256
POP-4® polymer (960 samples) for 3500/3500xL Genetic Analyzers 4393710
POP-4® polymer (384 samples) for 3500/3500xL Genetic Analyzers 4393715
Conditioning reagent 4393718
8-Capillary array, 36 cm for 3500 Genetic Analyzers 4404683
24-Capillary array, 36 cm for 3500xL Genetic Analyzers 4404687
96-well retainer & base set (Standard) 3500/3500xL Genetic Analyzers 4410228
8-Tube retainer & base set (Standard) for 3500/3500xL Genetic Analyzers 4410231
8-Strip Septa for 3500/3500xL Genetic Analyzers 4410701
96-Well Septa for 3500/3500xL Genetic Analyzers 4412614
Septa Cathode Buffer Container, 3500 series 4410715
GeneScan™ 600 LIZ® Size Standard v2.0 4408399
DS-33 Matrix Standard Kit (Dye Set G5) 4345833

For a complete list of parts and accessories for the 3500/3500xL instrument, refer to the Applied Biosystems 3500/3500xL
Genetic Analyzer User Guide (Pub. no. 4401661)
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Appendix B Ordering Information
Equipment and materials not included

Item? Source
310 Analyzer materials
310 DNA Analyzer capillary array, 47-cm 402839
0.5 mL sample tray 5572
96-well tray adaptor (for 9700 thermal cycler trays) 4305051
GeneScan™ 500 LIZ® Size Standard 4322682
OR OR
GeneScan™ 600 LIZ® Size Standard v2.0 4408399
Running Buffer, 10X 4335643
Genetic analyzer septa retainer clips for 96-tube sample tray 402866
Genetic analysis sample tubes (0.5-mL] 401957
Septa for 0.5-mL sample tubes 401956
DS-33 Matrix Standard Set (6-FAM™, VIC®, NED™, PET®, and LIZ® dyes) for 310/377 systems 4318159
MicroAmp® 8-tube strip, 0.2-mL N8010580
MicroAmp® 96-well base (holds 0.2-mL reaction tubes) N8010531
MicroAmp® 96-well full plate cover N8010550
MicroAmp® 96-well tray/retainer set 403081
POP-4® polymer for the 310 Genetic Analyzer 402838

For a complete list of parts and accessories for the 310 instrument, refer to Appendix B of the 370 Genetic Analyzer User

Guide (Pub. no. 4317588).

PCR Amplification

MicroAmp® 96-well tray N8010541
MicroAmp® reaction tube with cap, 0.2-mL N8010540
MicroAmp® 8-tube strip, 0.2-mL N8010580
MicroAmp® 8-cap strip N8010535
MicroAmp® 96-well tray/retainer set 403081
MicroAmp® 96-well base N8010531
MicroAmp® clear adhesive film 4306311
MicroAmp® optical adhesive film 4311971
MicroAmp® optical 96-well reaction plate N8010560
Other user-supplied materials

Hi-Di™ Formamide, 25-mL 4311320
Aerosol resistant pipette tips MLS
Microcentrifuge tubes MLS
Pipettors MLS
Tape, labeling MLS
Tube, 50-mL Falcon MLS
Tube decapper, autoclavable MLS
Deionized water, PCR grade MLS
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E Appendix B Ordering Information

Equipment and materials not included

ltemT Source
Tris-HCL, pH 8.0 MLS
EDTA, 0.5 M MLS
Vortex MLS

t For the Safety Data Sheet (SDS) of any chemical not distributed by Life Technologies, contact the chemical manufacturer. Before handling any
chemicals, refer to the SDS provided by the manufacturer, and observe all relevant precautions.
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PCR Work Areas

Work area setup and labdesign............ ... i 125
PCRsetupworkarea......... ...t 125
Amplified DNA workarea . ..............uuuuiiiiiiiiinnnn 126

Work area setup and lab design

Many resources are available for the appropriate design of a PCR laboratory. If you are
using the AmpF(STR® Identifiler® PCR Amplification Kit for:

e Forensic DNA testing, refer to “Forensic Laboratories: Handbook for Facility
Planning, Design, Construction and Moving,” National Institute of Justice, 1998)

* Parentage DNA testing, refer to the “Guidance for Standards for Parentage
Relationship Testing Laboratories,” American Association of Blood Banks, 7th
edition, 2004

The sensitivity of the Identifiler® Kit (and other PCR-based tests) enables amplification
of minute quantities of DNA, necessitating precautions to avoid contamination of
samples yet to be amplified (Kwok and Higuchi, 1989).

Also take care while handling and processing samples to prevent contamination by
human DNA. Wear gloves at all times and change them frequently. Close sample tubes
when not in use. Limit aerosol dispersal by handling sample tubes and reagents
carefully.

Note: We do not intend these references for laboratory design to constitute all
precautions and care necessary for using PCR technology.

PCR setup work area

IMPORTANT! These items should never leave the PCR Setup Work Area.

e Calculator

* Gloves, disposable

¢ Marker pen, permanent
¢ Microcentrifuge

* Microcentrifuge tubes, 1.5-mL, or 2.0-mL, or other appropriate clean tube (for
Master Mix preparation)

* Microcentrifuge tube rack
* Pipette tips, sterile, disposable hydrophobic filter-plugged
¢ DPipettors
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Appendix C PCR Work Areas
Amplified DNA work area

¢ Tube decapper, autoclavable

e Vortex

Amplified DNA work area

IMPORTANT! Place the thermal cyclers in the Amplified DNA Work Area.

You can use the following systems:
* GeneAmp® PCR System 9700 with the Silver 96-Well Block
* GeneAmp® PCR System 9700 with the Gold-plated Silver 96-Well Block

IMPORTANT! The Identifiler® Kit is not validated for use with the GeneAmp®
PCR System 9700 with the Aluminium 96-Well Block. Use of this thermal cycling
platform may adversely affect performance of the Identifiler® Kit.

e Veriti® 96-Well Thermal Cycler

126 AmpFISTR® Identifiler® PCR Amplification Kit User Guide



Safety

WARNING! GENERAL SAFETY. Using this product in a manner not specified
in the user documentation may result in personal injury or damage to the
instrument or device. Ensure that anyone using this product has received
instructions in general safety practices for laboratories and the safety
information provided in this document.

* Before using an instrument or device, read and understand the safety
information provided in the user documentation provided by the
manufacturer of the instrument or device.

* Before handling chemicals, read and understand all applicable Safety Data
Sheets (SDSs) and use appropriate personal protective equipment (gloves,
gowns, eye protection, etc). To obtain SDSs, see the “Documentation and
Support” section in this document.
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m Appendix D Safety
Chemical safety

Chemical safety

WARNING! GENERAL CHEMICAL HANDLING. To minimize hazards,
ensure laboratory personnel read and practice the general safety guidelines for
chemical usage, storage, and waste provided below, and consult the relevant
SDS for specific precautions and instructions:

Read and understand the Safety Data Sheets (SDSs) provided by the
chemical manufacturer before you store, handle, or work with any chemicals
or hazardous materials. To obtain SDSs, see the “Documentation and
Support” section in this document.

Minimize contact with chemicals. Wear appropriate personal protective
equipment when handling chemicals (for example, safety glasses, gloves, or
protective clothing).

Minimize the inhalation of chemicals. Do not leave chemical containers
open. Use only with adequate ventilation (for example, fume hood).

Check regularly for chemical leaks or spills. If a leak or spill occurs, follow
the manufacturer's cleanup procedures as recommended in the SDS.
Handle chemical wastes in a fume hood.

Ensure use of primary and secondary waste containers. (A primary waste
container holds the immediate waste. A secondary container contains spills
or leaks from the primary container. Both containers must be compatible
with the waste material and meet federal, state, and local requirements for
container storage.)

After emptying a waste container, seal it with the cap provided.
Characterize (by analysis if necessary) the waste generated by the particular
applications, reagents, and substrates used in your laboratory.

Ensure that the waste is stored, transferred, transported, and disposed of
according to all local, state/provincial, and/or national regulations.
IMPORTANT! Radioactive or biohazardous materials may require special
handling, and disposal limitations may apply.

Specific chemical CAS Chemical Phrase
handling
26628-22-8 | Sodium Azide Sodium azide may react with lead and copper
plumbing to form highly explosive metal azides.
128 AmpFISTR® Identifiler® PCR Amplification Kit User Guide



Appendix D Safety
Biological hazard safety

Biological hazard safety

WARNING! Potential Biohazard. Depending on the samples used on this
instrument, the surface may be considered a biohazard. Use appropriate
decontamination methods when working with biohazards.

@ WARNING! BIOHAZARD. Biological samples such as tissues, body fluids,

infectious agents, and blood of humans and other animals have the potential to
transmit infectious diseases. Follow all applicable local, state/provincial, and/or
national regulations. Wear appropriate protective equipment, which includes
but is not limited to: protective eyewear, face shield, clothing/lab coat, and
gloves. All work should be conducted in properly equipped facilities using the
appropriate safety equipment (for example, physical containment devices).
Individuals should be trained according to applicable regulatory and company/
institution requirements before working with potentially infectious materials.
Read and follow the applicable guidelines and/or regulatory requirements in
the following:
In the U.S.:

¢ U.S. Department of Health and Human Services guidelines published in
Biosafety in Microbiological and Biomedical Laboratories found at:
www.cdc.gov/biosafety

* Occupational Safety and Health Standards, Bloodborne Pathogens
(29 CFR§1910.1030), found at: www.access.gpo.gov/nara/cfr/waisidx_01/
29cfr1910a_01.html

* Your company’s/institution’s Biosafety Program protocols for working with/
handling potentially infectious materials.

* Additional information about biohazard guidelines is available at:
www.cdc.gov

In the EU:

Check local guidelines and legislation on biohazard and biosafety precaution
and refer to the best practices published in the World Health Organization
(WHO) Laboratory Biosafety Manual, third edition, found at: www.who.int/
csr/resources/publications/biosafety/ WHO_CDS_CSR_LYO_2004_11/en/
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Documentation and Support

Related documentation

Document title Pub. no.
AmpF(STR® Identifiler® PCR Amplification Kit: Human Identification: Application Note 040302
3100/3100-Avant Data Collection v2.0 User Guide 4347102
3100/3100-Avant Genetic Analyzers Using Data Collection Software v2.0 User Bulletin 4350218
3100 Genetic Analyzer User Manual [Data Collection v1.1) 4315834

3100/3100-Avant Genetic Analyzers Protocols for Processing AmpF(STR® PCR Amplification Kit PCR Products 4332345
User Bulletin

Applied Biosystems 3130/3100x! Genetic Analyzers Using Data Collection Software v3.0 User Bulletin 4363787
Applied Biosystems 3130/3130xl Genetic Analyzers Getting Started Guide 4352715
Applied Biosystems 3130/3130x! Genetic Analyzers Maintenance, Troubleshooting, and Reference Guide 4352716
Applied Biosystems 3130/3130x! Genetic Analyzers Quick Reference Card 4362825
Applied Biosystems 3130/3130xl Genetic Analyzers AB Navigator Software Administrator Guide 4359472
Applied Biosystems 3130/3100xt DNA Analyzers User Guide 4331468
Applied Biosystems 3500/3500xL Genetic Analyzer Quick Reference Card 4401662
Applied Biosystems 3500/3500xL Genetic Analyzer User Guide, Data Collection v1.0 4401661

Applied Biosystems 3500/3500xL Genetic Analyzer User Bulletin: Solutions to issues related to software, data, 4445098
hardware, and consumables

Note: Additional user bulletins may be available at www.lifetechnologies.com

Applied Biosystems 3730/3730xl Genetic Analyzer Getting Started Guide 4359476
GeneAmp® PCR System 9700 Base Module User’s Manual N805-0200
Veriti® 96-Well Thermal Cycler AmpFISTR®Kit Validation User Bulletin 4440754
Quantifiler® Kits: Quantifiler® Human DNA Quantification Kit and Quantifiler® Y Human Male DNA 4344790
Quantification Kit User's Manual

PrepFiler® Forensic DNA Extraction Kit User Guide 4390932
GeneMapper® ID Software Version 3.1 Human Identification Analysis User Guide 4338775
GeneMapper® ID Software Versions 3.1 and 3.2 Human Identification Analysis Tutorial 4335523
Installation Procedures and New Features for GeneMapper® ID Software v3.2 User Bulletin 4352543
GeneMapper® ID-X Software Version 1.0 Getting Started Guide 4375574
GeneMapper® ID-X Software Version 1.0 Quick Reference Guide 4375670
GeneMapper® ID-X Software Version 1.0 Reference Guide 4375671
GeneMapper® ID-X Software Version 1.1 (Mixture Analysis] Getting Started Guide 4396773
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Documentation and Support

Obtain SDSs
Document title Pub. no.
GeneMapper® ID-X Software Version 1.1 (Mixture Analysis] Quick Reference Guide 4402094
GeneMapper® ID-X Software Version 1.2 Reference Guide 4426481
GeneMapper® ID-X Software Version 1.2 Quick Reference Guide 4426482

Portable document format (PDF) versions of this guide and the documents listed
above are available at www.lifetechnologies.com.

Note: To open the user documentation available from the Applied Biosystems web
site, use the Adobe® Acrobat® Reader® software available from www.adobe.com.

Obtain SDSs

Safety Data Sheets (SDSs) are available from www.lifetechnologies.com/support.

Note: For the SDSs of chemicals not distributed by Life Technologies, contact the
chemical manufacturer.

Obtain support

For HID support:

¢ In North America - Send an email to HIDTechSupport@lifetech.com, or call
888-821-4443 option 1.

* Outside North America — Contact your local support office.
For the latest services and support information for all locations, go to:
www.lifetechnologies.com

At the website, you can:

* Access worldwide telephone and fax numbers to contact Technical Support and
Sales facilities

* Search through frequently asked questions (FAQs)
¢ Submit a question directly to Technical Support

* Search for user documents, SDSs, vector maps and sequences, application notes,
formulations, handbooks, certificates of analysis, citations, and other product
support documents

¢ Obtain information about customer training

* Download software updates and patches

Limited Product Warranty

Applied Biosystems and/or its affiliate(s) warrant their products as set forth in the Life
Technologies' General Terms and Conditions of Sale found on Life Technologies’
website at www.lifetechnologies.com/termsandconditions. If you have any
questions, please contact Life Technologies at www.lifetechnologies.com/support.
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